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Product notice

This user guide describes features that are 
common to most models. Some features may 
not be available on your computer.

Not all features are available in all editions of 
Windows. This computer may require upgraded 
and/or separately purchased hardware, drivers 
and/or software to take full advantage of 
Windows functionality. Go to 
http://www.microsoft.com for details.

Software terms

By installing, copying, downloading, or 
otherwise using any software product 
preinstalled on this computer, you agree to be 
bound by the terms of the HP End User License 
Agreement (EULA). If you do not accept these 
license terms, your sole remedy is to return the 
entire unused product (hardware and software) 
within 14 days for a full refund subject to the 
refund policy of your seller.

For any further information or to request a full 
refund of the price of the computer, please 
contact your seller.

This computer may require upgraded and/ or 
separately purchased hardware and/or a DVD 
drive to install the Windows 7 software and 
take full advantage of Windows 7 functionality. 
See http://windows.microsoft.com/en-us/ 
windows7/get-know-windows-7 for details.

http://www.microsoft.com
http://windows.microsoft.com/en-us/ windows7/get-know-windows-7
http://windows.microsoft.com/en-us/ windows7/get-know-windows-7


Important Notice about Customer Self-Repair Parts

CAUTION: Your computer includes Customer Self-Repair parts and parts that should only be accessed by an 
authorized service provider. See Chapter 5, "Removal and replacement procedures for Customer Self-Repair 
parts," for details. Accessing parts described in Chapter 6, "Removal and replacement procedures for 
Authorized Service Provider only parts," can damage the computer or void your warranty.
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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not place 
the computer directly on your lap or obstruct the computer air vents. Use the computer only on a hard, flat 
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as 
pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft 
surface, such as pillows or rugs or clothing, during operation. The computer and the AC adapter comply with 
the user-accessible surface temperature limits defined by the International Standard for Safety of 
Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP ProBook 470 G2 Notebook PC

Processors Intel® Core™ i7 processor, Dual Core, 4th generation (4-MB L3 cache)

4558U, 2.8-GHz/3.3-GHz Core Turbo/Intel Iris Graphics 5100

4510U, 2.0-GHz/3.1-GHz Core Turbo/Intel HD Graphics 5000

Intel Core i5 processors, Dual Core, 4th generation (3-MB L3 cache)

4210U, 1.7-GHz/2.7-GHz Core Turbo processor/Intel HD Graphics 4400

Intel Core i3 processors, Dual Core, 4th generation (3-MB L3 cache)

4030U, 1.9-GHz processor/Intel HD Graphics 4400

 Intel Core i7 processor, Dual Core, 5th generation (1600MHz, 4-MB L3 cache, 15W, Intel HD 5500 Graphics)

5500U, 2.4-GHz/3.0-GHz Core Turbo

Intel Core i5 processor, Dual Core, 5th generation (1600MHz, 3-MB L3 cache, 15W, Intel HD 5500 Graphics)

5200U, 2.2-GHz/2.7-GHz Core Turbo

Intel Core i3 processor, Dual Core, 5th generation (1600MHz, 3-MB L3 cache, 15W, Intel HD 5500 Graphics)

5020U, 2.2-GHz

5015U, 2.1-GHz

5010U, 2.1-GHz

5005U, 2.0-GHz

Chipset Integrated with processor

Graphics Switchable discrete (Intel processors):

AMD Radeon R5 M255 with 2 GB or 1 GB dedicated video memory

 Supports HD decode, DX11, HDMI, PX7.0

Panel HD+ LVDS wedge

 43.9-cm (17.3-inch), anti-glare, HD+, 1600x900, SVA, 200 nits, 1 or 2 WLAN antennas

 FHD LVDS wedge

 43.9-cm (17.3-inch), anti-glare, FHD, 1920x1080, WVA, 300 nits, 1 or 2 WLAN antennas

Memory Two customer-accessible memory module slots supporting up to 16 GB of RAM

 Supports dual-channel memory

 PC3L-12800, 1600-MHz, DDR3L SODIMMs

 Supports the following configurations:

● 16384 MB (8192 × 2; dual channel)

● 12288 MB (8192 + 4096; dual channel)

● 8192 MB (8192 × 1)
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Category Description

● 8192 MB (4096 × 2; dual channel)

● 6144 MB (4096 + 2048; dual channel)

● 4096 MB (4096 × 1)

● 2048 MB (2048 × 1)

Primary storage Supports 7-mm/9.5-mm, 2.5-in SATA hard drives with HP 3D DriveGuard

 Customer-accessible

 Supports the following 7 mm/9.5 mm, 2.5 inch hard drives:

● 1.5-TB, 5400-rpm

● 1-TB, 5400-rpm

● 750-GB, 7200-rpm

● 500-GB, 7200-rpm

● 500-GB, 5400-rpm, hybrid (8-GB SSD) MLC

● 500-GB, 5400-rpm

● 320-GB, 5400-rpm

Supports the following 2.5 inch solid-state drives:

● 256-GB, TLC

● 128-GB, TLC

● 128-GB

Fixed optical drives Supports the following 9.5-mm SATA optical drives:

● DVD-ROM

● DVD+/-RW SuperMulti DL

● Blu-ray ROM DVD+/-RW SuperMulti DL

 Supports no optical drive option

Audio/Visual Integrated camera (720p HD)

 Stereo speakers (2)

 Integrated dual-array microphone (webcam models only)

 Integrated mono microphone (non-webcam models only)

 Headphone/microphone combo jack

 Realtek ALC3227-CG

 Skype-ready

 HD audio with DTS Sound+

 Supports “no camera” option

Ethernet Realtek RTL8161GSH-CG 10/100/1000

 S3/S4/S5 wake on LAN (AC mode and battery mode)

 NIC power down technology
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Category Description

 Ethernet cable not included

Wireless Integrated WLAN options by way of wireless module:

 WLAN antennas built into display assembly

 Supports “no WLAN/Bluetooth” option

 Integrated WLAN options via Minicard:

● Intel 802.11 a/b/g/n/AC 2x2 +BT Combo (Wilkins Peak 2) - no vPro

● Intel 802.11 a/b/g/n/AC 1x1 +BT Combo (Wilkins Peak 1)

● QCA 802.11 b/g/n 1x1 (Marilyn) Backup

● Broadcom 802.11 a/b/g/n 2x2 +BT Combo (Bumblebee) w/o WiDi

● Broadcom 802.11 b/g/n 1x1 +BT Combo (Harrier) Backup

● Realtek 802.11 b/g/n 1x1 (Focus)

● Realtek 802.11 b/g/n 1x1 +BT Combo (Skyray)

 Wireless Personal Area Network (PAN) only supported by Bluetooth 4.0 combo card

External media 
card

Digital Media Reader Slot

Supports SD, SDHC, SDXC

Ports Headphone/Microphone Combo Jack

 RJ-45 (Ethernet, includes link and activity lights)

 USB 3.0 (2)

 USB 2.0 (2)

 VGA (Dsub 15-pin) supporting 2048 × 1536 external resolution at 50-GHz (hot plug/unplug with auto-detect)

 HDMI 1.4

 Multi-pin AC port

Keyboard/pointing 
devices

Full-sized, chiclet, spill-resistant keyboard with numeric keypad

 Backlit, full-sized, chiclet, spill-resistant keyboard with numeric keypad

 Touchpad includes: on/off button on board; 2-way scroll with legend, taps enabled by default, 2-finger scrolling 
and zoom enabled by default

Power 
requirements

90-W Smart AC adapter with localized cable plug support (3-wire plug with ground pin)

 65-W Smart AC adapter with localized cable plug support (3-wire plug with ground pin)

 Power cord: 3-wire plug - 1.8 m or 1.0 m

 6-cell, 51-Wh, 2.55 Ah, Li-ion battery (long life)

6-cell, 47-Wh, 2.2 Ah, Li-ion battery

Security Integrated fingerprint reader

No fingerprint reader option

Security lock
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Category Description

TPM SLB9660 (FW ver. 1.2) (Infineon; soldered down)

TPM support

Operating system Preinstalled:

 Windows 7 Professional 64

 Windows 7 Home Premium 64

 Windows 7 Home Basic 64

 Windows 8.1 Professional 64-bit Digital Product Key (DPK) with Windows 7 Professional 64

 Windows 8.1 Professional 64-bit Digital Product Key (DPK) with Windows 7 Professional 64 – MSNA

 Windows 8.1 China (CH) 64-bit

 Windows 8.1 Emerging Markets (EM) 64-bit

 Windows 8.1 Multi-language (ML) 64-bit

 Windows 8.1 Professional 64-bit

 Windows 8.1 Professional 64-bit – MSNA

 Windows 10 Home 64

 Windows 10 Home 64 Single Language

 Windows 10 Home 64 Chinese Market

 Windows 10 Home 64 Chinese Market – CPPP

 Windows 10 Home 64 High-end

 Windows 10 Home 64 High-end Single Language

 Windows 10 Home 64 High-end Chinese Market

 Windows 10 Professional 64

 Windows 10 Professional 64 Downgrade Windows 7 32

 Windows 10 Professional 64 Downgrade Windows 7 64

 FreeDOS 2.0

 Ubuntu Linux

Restore Media (DRDVD/SRDVD):

 DRDVD Windows 10

 DRDVD Windows 8.1

 DRDVD Windows 7

 SRDVD Ubuntu Linux

 Restore Media (OSDVD):

 Windows 7 Home Basic 64

 Windows 7 Home Premium 64

 Windows 7 Professional 32
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Category Description

 Windows 7 Professional 64

 Windows 8.1 Professional 64

 Windows 8.1 64-bit

 Windows 8.1 Country Specific 64-Bit

 Windows 8.1 Emerging Market 64-Bit

 Web-only support:

 Windows 7 Professional 32

 Windows 7 Enterprise 64

 Windows 7 Enterprise 32

 Windows 8.1 Enterprise 64

 Windows 10 Enterprise

 Certified:

 Microsoft WHQL

Serviceability End-user replaceable parts:

 AC adapter

 Battery (system)

 Hard drive

 Memory module

 Optical drive

 WLAN module

 Keyboard
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2 External component identification

Display

Component Description

(1) Internal microphones (2) Record sound.

(2) Webcam light On: The webcam is in use.

(3) Webcam Records video and captures photographs. Some models allow you to 
video conference and chat online using streaming video.

To use the webcam:

Windows 7: Select Start > All Programs > Communication and Chat 
> CyberLink YouCam.

Windows 8.1: Access HP Support Assistant. To access HP Support 
Assistant, from the Start screen, select the HP Support Assistant 
app.

Windows 10: Type camera in the taskbar search box, and then 
select Camera.

(4) WLAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless local 
area networks (WLAN).

(5) Internal display switch Turns off the display or initiates Sleep if the display is closed while 
the power is on.
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Component Description

NOTE: The display switch is not visible from the outside of the 
computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around the 
antennas free from obstructions. For wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental Notices 
that applies to your country or region. To access this guide:

Windows 7: Select Start > Help and Support > User Guides.

Windows 8.1: From the Start screen, type support, and then select the HP Support Assistant app.

Windows 10: Select Start, select All apps, select HP Help and Support, and then select HP Documentation.

Top

TouchPad

Component Description

(1)  TouchPad on/off button Turns the TouchPad on and off.

(2)  TouchPad zone Moves the pointer and selects or activates items on the screen.

NOTE: The TouchPad also supports edge-swipe gestures.

(3)  Left TouchPad button Functions like the left button on an external mouse.

(4)  Right TouchPad button Functions like the right button on an external mouse.
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Lights

Component Description

(1) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state, a power-saving 
state. The computer shuts off power to the display and 
other unneeded components.

● Off: The computer is off or in Hibernation. Hibernation is a 
power-saving state that uses the least amount of power.

(2)  Caps lock light On: Caps lock is on, which switches the keys to all capital letters.

(3) Microphone mute light ● Amber: microphone sound is off.

● Off: microphone sound is on.

(4)  Num lock light On: Num lock is on.

(5) Wireless light White: An integrated wireless device, such as a wireless local area 
network (WLAN) device and/or a Bluetooth® device, is on.

NOTE: On some models, the wireless light is amber when all 
wireless devices are off.

(6) Speaker mute light ● Amber: Computer sound is off.

● White: Computer sound is on.

(7)  TouchPad light ● Amber: The TouchPad is off.

● Off: The TouchPad is on.
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Buttons, speakers, and fingerprint reader (select models only)

Component Description

(1) Power button ● When the computer is off, press the button to turn on the 
computer.

● When the computer is on, press the button briefly to initiate 
Sleep.

● When the computer is in the Sleep state, press the button 
briefly to exit Sleep.

● When the computer is in Hibernation, press the button 
briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button will 
result in the loss of unsaved information.

If the computer has stopped responding and Windows® shutdown 
procedures are ineffective, press and hold the power button for at 
least 5 seconds to turn off the computer.

To learn more about your power settings, see your power 
options:

Windows 7: Select Start > Control Panel > System and Security 
> Power Options.

Windows 8.1: From the Start screen, type power, select Power 
and sleep settings, and then select Power and sleep from the 
list of applications.

Windows 10: Type power in the taskbar search box, and then 
select Power and sleep settings.

– or –
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Component Description

Right-click the Start button, and then select Power Options.

(2)  Speakers (2) Produce sound.

(3) Wireless button Turns the wireless feature on or off but does not establish a 
wireless connection.

(4) Speaker mute button Mutes and restores speaker sound.

(5)  Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a password 
logon.

Keys

Component Description

(1)  esc key Displays system information when pressed in combination with 
the fn key.

(2)  fn key Executes frequently used system functions when pressed in 
combination with a function key, the num lk key, or the esc key.

(3) Windows key Windows 7: Displays the Windows Start menu.

Windows 8.1: Returns you to the Start screen from an open app 
or the Windows desktop.

NOTE: Pressing the Windows key again will return you to the 
previous screen.

Windows 10: Opens the Windows Start menu.

NOTE: Pressing the Windows key again will close the Start 
menu.

(4)  Function keys Execute frequently used system functions when pressed in 
combination with the fn key.
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Component Description

(5)  num lk key Alternates between the navigational and numeric functions on 
the integrated numeric keypad.

(6)  Integrated numeric keypad When num lk has been enabled, it can be used like an external 
numeric keypad.

Bottom

Component Description

(1)  Vent Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool 
internal components and prevent overheating. It is normal 
for the internal fan to cycle on and off during routine 
operation.

(2) Service door Provides access to the hard drive bay and the memory 
module slots.

(3) Battery release latches (2) Releases the battery.

(4)  Service door Provides access to the wireless LAN (WLAN) module slot.
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Component Description

CAUTION: To prevent an unresponsive system, replace 
the wireless module only with a wireless module 
authorized for use in the computer by the governmental 
agency that regulates wireless devices in your country or 
region. If you replace the module and then receive a 
warning message, remove the module to restore computer 
functionality, and then contact support through HP 
Support Assistant.

To access Help and Support in Windows 7: Select Start > 
Help and Support.

To access HP Support Assistant: in Windows 8.1: From the 
Start screen, select the HP Support Assistant app.

Windows 10:

Type support in the taskbar search box, and then select 
the HP Support Assistant app.

- or -

Click the question mark icon in the taskbar.

(5)  Battery bay Holds the battery.

Front

Component Description

(1) Hard drive light ● Blinking white: The hard drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the 
hard drive.

(2)  Memory card reader Reads optional memory cards that store, manage, share, 
or access information.
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Left

Component Description

(1) Power connector Connects an AC adapter.

(2)  AC adapter/Battery light ● White: The computer is connected to external power and 
the battery is charged from 90 to 99 percent.

● Amber: The computer is connected to external power and 
the battery is charged from 0 to 89 percent.

● Off: The battery is fully charged.

(3)  Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool 
internal components and prevent overheating. It is normal for 
the internal fan to cycle on and off during routine operation.

(4) External monitor port Connects an external VGA monitor or projector.

(5) RJ-45 (network) jack/lights Connects a network cable.

● Green (right): The network is connected.

● Amber (left): Activity is occurring on the network.

(6) HDMI port Connects an optional video or audio device, such as a high-
definition television, any compatible digital or audio component, 
or a high-speed HDMI device.

(7) USB 3.0 ports (2) Each USB 3.0 port connects an optional USB device, such as a 
keyboard, mouse, external drive, printer, scanner or USB hub.
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Right

Component Description

(1) Audio-out (headphone)/Audio-in (microphone) 
jack

Connects optional powered stereo speakers, headphones, 
earbuds, or a headset. Also connects an optional headset 
microphone. This jack does not support optional microphone-
only devices.

WARNING! To reduce the risk of personal injury, adjust the 
volume before putting on headphones, earbuds, or a headset. 
For additional safety information, see the Regulatory, Safety, 
and Environmental Notices.

To access this document:

Windows 7:

Select Start > Help and Support > User Guides.

Windows 8.1:

From the Start screen, type support, and then select the HP 
Support Assistant app.

‒ or –

From the Windows desktop, click the question mark icon in the 
notification area, at the far right of the taskbar.

Windows 10:

Select Start, select All apps, select HP Help and Support, and 
then select HP Documentation.

NOTE: When a device is connected to the jack, the computer 
speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor 
connector that supports both audio-out (headphone) and 
audio-in (microphone).

(2) USB 2.0 ports (2) Connects an optional USB device, such as a keyboard, mouse, 
external drive, printer, scanner or USB hub.

(3)  Optical drive (select models only) Depending on your computer model, reads an optical disc or 
reads and writes to an optical disc.

(4)  Optical drive eject button (select models only) Releases the optical drive disc tray.

(5) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but 
it may not prevent the computer from being mishandled or 
stolen.
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Labels
The labels affixed to the computer provide information you may need when you troubleshoot system 
problems or travel internationally with the computer.

IMPORTANT: Check the following locations for the labels described in this section: the bottom of the 
computer, inside the battery bay, under the service door, or on the back of the display.

● Service label—Provides important information to identify your computer. When contacting support, you 
will probably be asked for the serial number, and possibly for the product number or the model number. 
Locate these numbers before you contact support.

Your service label will resemble one of the examples shown below. Refer to the illustration that most 
closely matches the service label on your computer.

Component  

(1) Serial number  

(2) Product number  

(3) Warranty period  

(4) Model number (select products only)  

Component  

(1) Model name (select products only)  

(2) Product number  

(3) Serial number  

(4) Warranty period  

● Regulatory label(s)—Provide(s) regulatory information about the computer.

● Wireless certification label(s)—Provide(s) information about optional wireless devices and the approval 
markings for the countries or regions in which the devices have been approved for use.
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3 Illustrated parts catalog

Computer major components
NOTE: Details about your computer, including model, serial number, product key, and length of warranty, 
are on the service tag at the bottom of your computer. See Labels on page 15 for details.

NOTE: HP continually improves and changes product parts. For complete and current information on 
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then 
follow the on-screen instructions.
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Item Description Spare part number

(1) Display panel, 43.9-cm (17.3-inch) not spared

(2) Keyboard (includes cable)

NOTE: For a list of keyboard country codes, see Keyboard on page 40.

 

 Backlit 768130-xxx

 No backlight 768787-xxx

(3) Top cover (includes touchpad assembly) 768390-001

(4) Touchpad button board 768140-001

(5) Power button board assembly 767442-001

(6) Card reader board 768384-001

(7) Function board 768380-001

(8) Fingerprint reader assembly (includes cable, bracket, and bezel) 768378-001

(9) System board (includes replacement thermal material)

All system boards use the following part numbers:

xxxxxx-001: Windows 7 or non-Windows operating systems

xxxxxx-501: Windows 8.1 Standard operating system

xxxxxx-601: Windows 8.1 or Windows 10 operating system

 

 Intel i7-4510U processor; 2-GB discrete graphics memory 768401-xxx

 Intel i5-4210U processor; 2-GB discrete graphics memory 768399-xxx

 Intel i3-4030U processor; 2-GB discrete graphics memory 768398-xxx

 Intel i7-4558U processor; 1-GB discrete graphics memory 768395-xxx

 Intel i5-4210U processor; 1-GB discrete graphics memory 768393-xxx

 Intel i3-4030U processor; 1-GB discrete graphics memory 768392-xxx

 Intel i7-5500U processor; 2-GB discrete graphics memory 807230-xxx

 Intel i7-5500U processor; 1-GB discrete graphics memory 823788-xxx

 Intel i5-5200U processor; 2-GB discrete graphics memory 807229-xxx

 Intel i5-5200U processor; 1-GB discrete graphics memory 807227-xxx

 Intel i3-5020U processor; 2-GB discrete graphics memory 807230-xxx

 Intel i3-5020U processor; 1-GB discrete graphics memory 823789-xxx

 Intel i3-5010U processor; 2-GB discrete graphics memory 807228-xxx

 Intel i3-5010U processor; 1-GB discrete graphics memory 807226-xxx

(10) USB/audio board 768382-001

(11) Memory modules (PC3L-12800, 1600-MHz, DDR3L)

 8-GB 693374-001

 4-GB 691740-001
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Item Description Spare part number

 2-GB 691739-001

(12) Optical drive extension board not spared

(13) RTC battery 738824-001

(14) WLAN module

 Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter 675794-001

 Realtek RTL8188EE 802.11bgn Wi-Fi Adapter 709848-001

 Broadcom BCM943228HMB 802.11abgn 2x2 Wi-Fi Adapter + Broadcom Bluetooth 4.0 Adapter 730668-001

 Broadcom BCM43142 802.11 bgn 1x1 Wi-Fi + BT4.0 HMC combo adapter 753076-001

 Realtek RT8723BE 802.11 bgn 1x1 Wi-Fi + BT4.0 combo adapter 753077-001

 Intel Dual Band Wireless-AC 7260 802.11 ac 2x2 WiFi + Intel Dual Band Wireless-AC 7260 BT 4.0 
combo adapter

784650-001

 Heat sink assembly (includes replacement thermal material)  

(15) For use in models with all processors except for the Intel i7-4558U 768050-001

 For use in models with an Intel i7-4558U processor 768049-001

(16) Power connector and cable 767432-001

(17) Fan 767433-001

(18) Speaker assembly 768389-001

(19) Battery, Li-ion  

 6-cell, 51 WHr, 2.55 Ah 757661-001

 6-cell, 47 WHr, 2.2 Ah 708457-001

(20) Base enclosure  

 For use in models with Intel Core 4th generation processors 768374-001

 For use in models with Intel Core 5th generation processors 807665-001

 Service doors, includes: 768385-001

(21) Small service door  

(22) Large service door  

(23) Hard drive  

 1.5-TB, 5400-rpm, 9.5 mm 747375-001

 1-TB, 5400-rpm 676521-001

 750-GB, 7200-rpm 778191-001

 750-GB, 5400-rpm 634250-001

 500-GB, 7200-rpm 703267-001

 500-GB, 5400-rpm, 7 mm, hybrid (8-GB SSD) 732000-001

 320-GB, 5400-rpm 778183-001

 Solid-state drive  
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Item Description Spare part number

 256-GB, TLC 817630-001

 128-GB 778175-001

 128-GB, TLC 822214-001

(24) Optical drive (includes bracket, bezel, and screws)

 Blu-ray ROM DVD±RW SuperMulti DL Drive 768473-001

 DVD±RW SuperMulti DL Drive 768475-001

 DVD-ROM drive 768474-001

Cable Kit

Item Description Spare part number

 Cable Kit 768377-001

(1) Battery connector cable  

(2) Display/webcam cable  
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Display components

Item Description Spare part number

(1) Display bezel  

 For use in models with a webcam 768375-001

 For use in models without a webcam 768376-001

(2) Webcam module 767457-001

 Microphone module 773563-001

(3) Display panel (raw), HD+  

 HD+, SVA, antiglare, flat 768386-001

 FHD, WVA, antiglare 810984-001

(4) WLAN antennas

Included in Display Rear Cover kit, 768373-001

not spared separately

(5) Display Hinge Kit (includes left and right hinges) 768379-001

(6) Display/webcam cable assembly 768377-001
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Item Description Spare part number

(in Cable Kit)

(7) Display rear cover (includes wireless antennas) 768373-001

Mass storage devices

Description Spare part number

Hard drives 

1.5-TB, 5400-rpm, 9.5 mm 747375-001

1-TB, 5400-rpm 676521-001

750-GB, 7200-rpm 778191-001

750-GB, 5400-rpm 634250-001

500-GB, 7200-rpm 703267-001

500-GB, 5400-rpm, 7 mm, hybrid (8-GB SSD) 732000-001

320-GB, 5400-rpm 778183-001

Solid-state drive

256-GB, TLC 817630-001

128-GB 778175-001

128-GB, TLC 822214-001

Hard Drive Hardware Kit (includes hard drive bracket and screws; not illustrated) 767437-001

Optical drives (include bezel, bracket, and screws)

Blu-ray ROM DVD±RW SuperMulti DL Drive 768473-001

DVD±RW SuperMulti DL Drive 768475-001

DVD-ROM drive 768474-001

Miscellaneous parts

Description Spare part number

AC adapters

90-W AC adapter 693712-001

90-W AC adapter for use in India 693712-001

65-W AC adapter 693711-001

65-W AC adapter for use in India 693710-001

Power cords, 1.83 m, 3-pin:

For use in Australia 490371-011
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Description Spare part number

For use in Europe, the Middle East, and Africa 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in the People’s Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in Thailand 490371-201

For use in the United Kingdom 490371-031

For use in the United States 490371-001

Power cords, 1.0 m, 3-pin:  

For use in Australia 755530-011

For use in Denmark 755530-081

For use in Europe, the Middle East, and Africa 755530-021

For use in India 755530-D61

For use in Israel 755530-BB1

For use in Italy 755530-061

For use in Japan 755530-291

For use in the People’s Republic of China 755530-AA1

For use in South Africa 755530-AR1

For use in South Korea 755530-AD1

For use in Switzerland 755530-111

For use in Taiwan 755530-AB1

For use in Thailand 755530-201

For use in the United Kingdom 755530-031

For use in the United States 755530-001

Power cords, 1.0 m, 2-pin:  

For use in Japan 762689-291

Rubber Kit (includes rubber base enclosure screw covers and mylar display bezel screw covers) 768387-001

Screw Kit 768388-001
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4 Removal and replacement procedures 
preliminary requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during disassembly 
and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all accompanying 
screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care 
when handling the plastic parts. Apply pressure only at the points designated in the maintenance 
instructions.
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the 
reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat 
the cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid 
bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught 
or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables 
tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the 
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is 
off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid 
touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure 
that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective 
packaging and label the package “FRAGILE.”

24 Chapter 4   Removal and replacement procedures preliminary requirements



Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine 
the degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many 
cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or 
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal 
cycle. Or the device may function normally for a while, and then degrade in the internal layers, reducing its life 
expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal components, 
observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described in this 
section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different 
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized 
equipment used for moving materials is wired to ground and that proper materials are selected to avoid 
static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and 
equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and 
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these 
items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a 
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap 
snugly against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips 
to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be 
used at standing workstations and are compatible with most types of shoes or boots. On conductive 
floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance 
between the operator and ground. To be effective, the conductive strips must be worn in contact with 
the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tapes

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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5 Removal and replacement procedures for 
Customer Self-Repair parts

CAUTION: The Customer Self-Repair program is not available in all locations. Installing a part not supported 
by the Customer Self-Repair program may void your warranty. Check your warranty to determine if Customer 
Self-Repair is supported in your location.

NOTE: HP continually improves and changes product parts. For complete and current information on 
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then 
follow the on-screen instructions.

Component replacement procedures
NOTE: Please read and follow the procedures described here to access and replace Customer Self-Repair 
parts successfully.

NOTE: Details about your computer, including model, serial number, product key, and length of warranty, 
are on the service tag at the bottom of your computer. See Labels on page 15 for details.

This chapter provides removal and replacement procedures for Customer Self-Repair parts.

There are as many as 13 screws that must be removed, replaced, or loosened when servicing Customer Self-
Repair parts. Make special note of each screw size and location during removal and replacement.
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Battery

Description Spare part number

6-cell, 51 WHr, 2.55 Ah Li-ion battery 757661-001

6-cell, 47 WHr, 2.2 Ah Li-ion battery 708457-001

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

To remove the battery:

CAUTION: Removing a battery that is the sole power source for the computer can cause loss of information. 
To prevent loss of information, save your work and shut down the computer through Windows before 
removing the battery.

1. Turn the computer upside down on a flat surface.

2. Slide the battery lock latch (1), and then slide the battery release latch (2) to release the battery.

3. Tilt the battery upward (3) and remove it from the computer (4).
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Service door

Description Spare part number

Service doors (includes large and small service door) 768385-001

Before removing the service door, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

To remove the service door:

1. With the battery bay away from you, loosen the service door screw (1). The service door screw secures 
both service doors.

2. Slide the larger service door away from the battery bay (2) to remove it.

NOTE: The larger service door provides access to the hard drive and memory modules.
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3. Slide the smaller service door away from the battery bay (3) to release it, and then lift the service door 
(4) to remove it.

NOTE: The smaller service door provides access to the wireless modules, optical drive security screw, 
and keyboard screws. You must remove the large service door to remove the small service door.
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Hard drive

Description Spare part number

Hard drive

1.5-TB, 5400-rpm, 9.5 mm 747375-001

1-TB, 5400-rpm 676521-001

750-GB, 7200-rpm 778191-001

750-GB, 5400-rpm 634250-001

500-GB, 7200-rpm 703267-001

500-GB, 5400-rpm, 7 mm, hybrid (8-GB SSD) 732000-001

320-GB, 5400-rpm 778183-001

Solid-state drive  

256-GB, TLC 817630-001

128-GB 778175-001

128-GB, TLC 822214-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the large service door (see Service door on page 30).

To remove a hard drive:

1. Remove the 4 Phillips PM2.5×4.0 screws (1) that secure the hard drive to the chassis.

2. Slide the hard drive (2) away from the center of the computer to disengage it from the connector.
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3. Pull the plastic tab (3) to remove the hard drive from the bay.

4. To remove the hard drive cover and bracket from the hard drive, lift the Mylar cover up off the drive (1), 
remove the 4 Phillips PM3.0×3.0 screws (2) that secure the bracket to the drive, and then lift the bracket 
up and off the hard drive (3).

Reverse this procedure to install a hard drive.
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Memory modules

NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of the computer.

If only one memory module is installed, it must be installed in the bottom socket.

Description Spare part number

2-GB (PC3L-12800, 1600-MHz, DDR3L) 691739-001

4-GB (PC3L-12800, 1600-MHz, DDR3L) 691740-001

8-GB (PC3L-12800, 1600-MHz, DDR3L) 693374-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may result in 
various system problems.

To update BIOS:

1. Navigate to www.hp.com.

2. Click Support & Drivers > click Drivers & Software.

3. In the Enter a product name/number box, type the computer model information, and then click Search.

4. Click the link for the computer model.

5. Select the operating system, and then click Next.

6. Under Step 2: Select a Download, click the BIOS link.

7. Click the link for the most recent BIOS.

8. Click the Download button, and then follow the on-screen instructions.

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the large service door (see Service door on page 30).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory module. 
(The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the memory 
module slot.

NOTE: The computer uses two memory sockets. The top socket houses the expansion memory 
module and the bottom socket houses the primary memory module. The removal procedure is the same 
for both memory sockets.

Reverse this procedure to install a memory module.
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Optical drive

NOTE: All optical drive spare part kits include an optical drive bezel, bracket, and screws.

Description Spare part number

DVD-ROM drive 768474-001

Blu-ray ROM DVD±RW SuperMulti DL Drive 768473-001

DVD±RW SuperMulti DL Drive 768475-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove both service doors (see Service door on page 30).

Remove the optical drive:

1. Remove the Phillips PM2.5×6.0 screw (1) that secures the optical drive to the computer.

2. Push the optical drive tab (2) to release the optical drive from the computer.

3. Remove the optical drive (3) from the computer.
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4. To remove the bracket from the optical drive, remove the Phillips PM2.0×3.0 screw (1) that secures the 
bracket to the drive, and then remove the bracket from the drive (2).

Reverse this procedure to install an optical drive.
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WLAN/Bluetooth combo card

The computer uses a card that provides both WLAN and Bluetooth functionality.

Description Spare part number

Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter 675794-001

Realtek RTL8188EE 802.11bgn Wi-Fi Adapter 709848-001

Broadcom BCM943228HMB 802.11abgn 2x2 Wi-Fi Adapter + Broadcom Bluetooth 4.0 Adapter 730668-001

Broadcom BCM43142 802.11 bgn 1x1 Wi-Fi + BT4.0 HMC combo adapter 753076-001

Realtek RT8723BE 802.11 bgn 1x1 Wi-Fi + BT4.0 combo adapter 753077-001

Intel Dual Band Wireless-AC 7260 802.11 ac 2x2 WiFi + Intel Dual Band Wireless-AC 7260 BT 4.0 combo 
adapter

784650-001

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove both service doors (see Service door on page 30).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal labeled “1”. 
The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal labeled “2”. If the 
computer is equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable connects to 
the middle terminal on the WLAN module.

2. Remove the two Phillips PM2.5×3.0 screws (2) that secure the WLAN module to the computer. (The edge 
of the module opposite the slot rises away from the computer.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective 
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.

Component replacement procedures 39



Keyboard

In this section, the first table provides the main spare part number for the keyboards. The second table 
provides the country codes.

Description Spare part number

Keyboard, backlit 768130-xxx

Keyboard, no backlight 768787-xxx

For use in country 
or region

Spare part 
number

For use in country 
or region

Spare part 
number

For use in country 
or region

Spare part 
number

Belgium -A41 India -D61 Saudi Arabia -171

Brazil -201 Israel -BB1 Slovenia -BA1

Bulgaria -261 Italy -061 South Korea -AD1

Canada -DB1 Japan -291 Spain -071

Czech Republic 
and Slovakia

-FL1 Latin America -161 Sweden and Finland -B71

Denmark -081 The Netherlands -B31 Switzerland -BG1

Denmark, Finland, and 
Norway

-DH1 Northern Africa -FP1 Taiwan -AB1

France -051 Norway -091 Thailand -281

Germany -041 Portugal -131 Turkey -141

Greece -151 Romania -271 United Kingdom -031

Hungary -211 Russia -251 United States -001

Iceland -DD1     

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove both service doors (see Service door on page 30).

Remove the keyboard:

1. Remove the 3 Phillips PM2.5×6.0 screws that secure the keyboard to the computer.
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2. Position the computer upright with the front toward you.

3. Open the computer as far as possible.

4. Slide the keyboard slightly downward toward the palm rest to disengage the top of the keyboard from 
the top cover.
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5. Rotate the top of the keyboard upward (1), and then lift the keyboard up at an angle (2) to disengage the 
tabs at the bottom of the keyboard.

NOTE: A cable connects the bottom of the keyboard to the system board. Make sure not to 
prematurely pull the keyboard cable out of the system board connector.

6. Rotate the keyboard until it rests on the palm rest (1).
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7. Disconnect the keyboard cable by lifting the keyboard connector latch (2), and then disconnect the 
keyboard cable from the system board (3).

8. Remove the keyboard.

Reverse this procedure to install the keyboard.

Component replacement procedures 43



6 Removal and replacement procedures for 
Authorized Service Provider parts

CAUTION: Components described in this chapter should only be accessed by an authorized service provider. 
Accessing these parts can damage the computer or void the warranty.

NOTE: HP continually improves and changes product parts. For complete and current information on 
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then 
follow the on-screen instructions.

Component replacement procedures
NOTE: Details about your computer, including model, serial number, product key, and length of warranty, 
are on the service tag at the bottom of your computer. See Labels on page 15 for details.

This chapter provides removal and replacement procedures for Authorized Service Provider only parts.

There are as many as 57 screws that must be removed, replaced, or loosened when servicing Authorized 
Service Provider only parts. Make special note of each screw size and location during removal and 
replacement.

Top cover

NOTE: Top cover spare part kits include the touchpad assembly.

Description Spare part number

Top cover (includes touchpad) 768390-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 29).

b. Service doors (see Service door on page 30).

c. Hard drive (Hard drive on page 32)

d. Optical drive (Optical drive on page 36)

e. Keyboard (see Keyboard on page 40)

Remove the top cover:
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1. Position the computer upside-down with the front toward you.

2. Remove the 5 rubber screw covers and 8 Torx T8M2.5×6.0 screws that secure the top cover to the 
computer.

3. Remove the 9 Torx T8M2.5×3.0 screws that secure the top cover to the computer.

4. Position the computer upright and open it as far as possible.

5. Disconnect the following cables from the system board:

● (1): Card reader board cable

● (2): Power button board cable

● (3): Function board cable

● (4): Speaker cable

● (5): USB board cable
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6. Remove the 4 Torx T8M2.5×6.0 screws (5) from the top of the computer.

7. Pry the top cover off the computer to disengage it.

NOTE: Begin by attempting to pry the top cover loose near the optical drive.

8. Lift the top of the top cover (1), and the lift the top cover up and remove it from the computer (2).

Reverse this procedure to install the top cover.
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Speaker assembly

Description Spare part number

Speaker assembly 768389-001

NOTE: You must remove the left speaker to remove to function board cable.

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Keyboard (see Keyboard on page 40)

c. Hard drive (Hard drive on page 32)

d. Optical drive (Optical drive on page 36)

e. Top cover (see Top cover on page 44)

Remove the speaker assembly:

1. Position the top cover upside-down.

2. Remove the 2 Phillips PM2.0×3.0 broadhead screws (1) that secure the speakers to the computer.

3. Slide the speakers toward each other to disengage them from the top cover (2).
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4. Remove the speakers from the top cover (3).

Reverse this procedure to install the speaker assembly.
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Fingerprint reader assembly

Description Spare part number

Fingerprint reader assembly (includes cable, bracket, and bezel) 768378-001

Before removing the fingerprint reader assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Keyboard (see Keyboard on page 40)

c. Hard drive (Hard drive on page 32)

d. Optical drive (Optical drive on page 36)

e. Top cover (see Top cover on page 44)

Remove the fingerprint reader assembly:

1. Position the top cover upside-down.

2. Slide the bracket toward the bottom of the top cover (1), and then lift it off the top cover (2).
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3. Remove the fingerprint reader board and cable assembly from the top cover (3).

Reverse this procedure to install the fingerprint reader assembly.

Power button board

Description Spare part number

Power button board assembly 767442-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30)

b. Keyboard (see Keyboard on page 40)

c. Hard drive (Hard drive on page 32)
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d. Optical drive (Optical drive on page 36)

e. Top cover (see Top cover on page 44)

Remove the power button board:

1. Position the top cover upside-down.

2. Remove the Phillips PM2.0×3.0 screw (1) that secures the power button board to the top cover.

3. Slide the board upward to disengage it from the tabs (2).

4. Lift the board up to remove it from the top cover (3), while guiding the cable through the hole in the top 
cover (4).

Reverse this procedure to install the power button board.
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Function board

Description Spare part number

Function board 768380-001

Before removing the function board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30)

b. Keyboard (see Keyboard on page 40)

c. Hard drive (Hard drive on page 32)

d. Optical drive (Optical drive on page 36)

e. Top cover (see Top cover on page 44)

Remove the function board:

1. Position the top cover upside-down.

2. Remove the Phillips PM2.0×3.0 screw (1) that secures the function board to the top cover.

3. Slide the board toward the top of the top cover (2), and then lift it off the top cover (3).
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4. On the front of the top cover, pull the cable to disengage it from the adhesive that secures it, and then 
pull the cable through the hole in the top cover (4).

5. Remove the function board from the top cover.

Reverse this procedure to install the function board.

Card reader board

Description Spare part number

Card reader board 768384-001

Before removing the card reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Keyboard (see Keyboard on page 40)
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c. Hard drive (Hard drive on page 32)

d. Optical drive (Optical drive on page 36)

e. Top cover (see Top cover on page 44)

Remove the card reader board:

NOTE: Before you remove the card reader, make sure nothing (memory card or plastic insert) in installed.

1. Position the top cover upside-down.

2. Disconnect the cable from the board (1).

3. Remove the two Phillips PM2.5×4.0 screws (2) that secure the card reader board to the computer.

4. Remove the card reader board from the top cover (3).

Reverse this procedure to install the card reader board.
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USB/audio board

Description Spare part number

USB/audio board 768382-001

Before removing the USB/audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Keyboard (see Keyboard on page 40)

c. Hard drive (Hard drive on page 32)

d. Optical drive (Optical drive on page 36)

e. Top cover (see Top cover on page 44)

Remove the USB/audio board:

1. Position the top cover upside-down.

2. Remove the Phillips PM2.5×4.0 screw (1) that secures the USB/audio board to the computer.

3. Disconnect the cable from the board (2).
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4. Lift the board off the top cover (3).

Reverse this procedure to install the USB/audio board.
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Touchpad button board

Description Spare part number

Touchpad button board 768140-001

Before removing the touchpad button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Keyboard (see Keyboard on page 40)

c. Hard drive (Hard drive on page 32)

d. Optical drive (Optical drive on page 36)

e. Top cover (see Top cover on page 44)

Remove the touchpad button board:

1. Position the top cover upside-down.

2. Disconnect the cable from the touchpad (1).

3. Disconnect the cable from the card reader board (2).

4. Remove the Phillips PM2.0×3.0 screw (3) that secures the button board to the top cover.

5. Lift the right side of the touchpad button board up, and then pull it to the right to remove it from the slot 
(4).
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6. Lift the touchpad button board off the top cover (5).

Reverse this procedure to install the touchpad board.
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Fan

Description Spare part number

Fan 767433-001

NOTE: To properly ventilate the computer, allow at least 7.6 cm (3.0 in) of clearance on the left side of the 
computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and 
is designed to turn on automatically when high temperature conditions exist. These conditions are affected by 
high external temperatures, system power consumption, power management/battery conservation 
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the 
ventilation grill located on the left side of the computer.

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29), and then remove the following components:

a. Service doors (see Service door on page 30).

b. Hard drive (Hard drive on page 32)

c. Optical drive (Optical drive on page 36)

d. Keyboard (see Keyboard on page 40)

e. Top cover (see Top cover on page 44)

To remove the fan:

1. Disconnect the fan cable (1) from the system board.
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2. Lift the fan from the computer (2).

Reverse this procedure to install the fan.
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Battery connector cable

The battery connector cable is included in the Cable Kit, spare part number 768377-001.

Before removing the battery connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Hard drive (Hard drive on page 32)

c. Optical drive (Optical drive on page 36)

d. Keyboard (see Keyboard on page 40)

e. Top cover (see Top cover on page 44)

Remove the battery connector cable:

1. Disconnect the battery connector cable from the system board (1).

2. Remove the 2 Phillips PM2.5×4.0 screws that secure the battery connector cable to the computer (2).

3. Remove the battery connector cable from the computer (3).
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Reverse this procedure to install the battery connector cable.

System board

NOTE: All system board spare part kits include replacement thermal material.

Description Spare part number

All system boards use the following part numbers:

xxxxxx-001: Windows 7 or non-Windows operating systems

xxxxxx-501: Windows 8.1 Standard operating system

xxxxxx-601: Windows 8.1 or Windows 10 operating system

Intel i7-4510U processor; 2-GB discrete graphics memory 768401-xxx

Intel i5-4210U processor; 2-GB discrete graphics memory 768399-xxx

Intel i3-4030U processor; 2-GB discrete graphics memory 768398-xxx

Intel i7-4558U processor; 1-GB discrete graphics memory 768395-xxx

Intel i5-4210U processor; 1-GB discrete graphics memory 768393-xxx

Intel i3-4030U processor; 1-GB discrete graphics memory 768392-xxx

Intel i7-5500U processor; 2-GB discrete graphics memory 807230-xxx

Intel i7-5500U processor; 1-GB discrete graphics memory 823788-xxx

Intel i5-5200U processor; 2-GB discrete graphics memory 807229-xxx

Intel i5-5200U processor; 1-GB discrete graphics memory 807227-xxx

Intel i3-5020U processor; 2-GB discrete graphics memory 807230-xxx

Intel i3-5020U processor; 1-GB discrete graphics memory 823789-xxx

Intel i3-5010U processor; 2-GB discrete graphics memory 807228-xxx

Intel i3-5010U processor; 1-GB discrete graphics memory 807226-xxx

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Hard drive (see Hard drive on page 32)

c. Optical drive (see Optical drive on page 36)
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d. Keyboard (see Keyboard on page 40)

e. Top cover (see Top cover on page 44)

When replacing the system board, be sure to remove the following components from the defective system 
board and install on the replacement system board:

● Memory modules (see Memory modules on page 34)

● WLAN/Bluetooth module (see WLAN/Bluetooth combo card on page 38)

Remove the system board:

1. Position the computer upright with the front toward you.

2. Disconnect the following cables from the system board:

(1) Power connector cable

(2) Display cable

(3) Battery connector cable

3. Remove the hillips PM2.5×4.0 screw (1) that secures the system board, the broadhead Phillips 
PM2.0×3.0 screw (2) that secures the optical drive extension board, and the broadhead Phillips 
PM2.0×3.0 screw (3) that secures the hard drive extension board to the computer.

4. Lift the right side of the system board up at an angle (4).
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5. Pull the system board up and toward the right to remove it from the computer (5).

Reverse this procedure to install the system board.
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Optical drive and hard drive extension boards

You must remove the system board to remove the optical drive extension board.

Before removing the optical drive extension board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Hard drive (see Hard drive on page 32)

c. Optical drive (see Optical drive on page 36)

d. WLAN module (see WLAN/Bluetooth combo card on page 38)

e. Keyboard (see Keyboard on page 40)

f. Top cover (see Top cover on page 44)

g. System board (see System board on page 62)

Remove the optical drive extension board:

1. Position the system board upright.

2. Pull the optical drive extension board (1) and/or the hard drive extension board (2) straight away from 
the side of the system board.

Reverse this procedure to install the drive extension boards.
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RTC battery

Description Spare part number

RTC battery 738824-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Hard drive (see Hard drive on page 32)

c. Optical drive (see Optical drive on page 36)

d. Keyboard (see Keyboard on page 40)

e. Top cover (see Top cover on page 44)

f. System board (see System board on page 62)

Remove the RTC battery:

1. Position the system board upside-down.

2. Using a flat tool, pry the battery out of the socket (1).
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3. Remove the battery from the socket (2).

Reverse this procedure to install the RTC battery.
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Heat sink assembly

All heat sink assembly spare part kits include replacement thermal material.

Description Spare part number

Heat sink assembly:

For use in models with discrete graphics and all processors except for the Intel i7-4558U 768050-001

For use in models with discrete graphics and an Intel i7-4558U processor 768049-001

Before removing the heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Hard drive (see Hard drive on page 32)

c. Optical drive (see Optical drive on page 36)

d. WLAN module (see WLAN/Bluetooth combo card on page 38)

e. Keyboard (see Keyboard on page 40)

f. Top cover (see Top cover on page 44)

g. System board (see System board on page 62)

Remove the heat sink assembly:

1. Position the system board upside-down.

2. Models are available with discrete graphics.

Discrete models:

a. To remove the heat sink assembly, in the order indicated on the heat sink, loosen the 6 captive 
Phillips screws (1) that secure the heat sink to the system board.
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b. Lift the heat sink from the system board (2).

NOTE: Thoroughly clean thermal material from the surfaces of the system board components (1)
(3) and the heat sink (2)(4) each time you remove the heat sink. All heat sink and processor spare 
part kits include thermal material.

Reverse this procedure to install the heat sink assembly.
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Display assembly

Entire display hinge-ups are not spared.

For a list of individual display spare parts, see Display components on page 20.

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Hard drive (see Hard drive on page 32)

c. Optical drive (see Optical drive on page 36)

d. WLAN module (see WLAN/Bluetooth combo card on page 38)

e. Keyboard (see Keyboard on page 40)

f. Top cover (see Top cover on page 44)

Remove the display assembly:

1. Position the computer upside down.

2. Pull the antenna cables through from the bottom of the computer. Position the computer upside down, 
and then remove the cables from the clips near the wireless modules (1), pulling the cables (2) through 
the holes (3) in the computer.
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3. Position the computer upright and open.

4. Disconnect the display cable from the system board (1).

5. Remove the WLAN antennas from the routing path along the base of the computer (2).

6. Place the computer upright and open as far as possible.

7. Remove the 5 Phillips PM2.5×4.0 screws (1) from the display hinges.
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8. Lift the display assembly straight up and remove it (2).

CAUTION: When installing the display assembly, be sure that the wireless antenna cables are routed 
and arranged properly.

Failure to properly route the antennas can result in degradation of the computer's wireless performance.

9. If you need to remove the display bezel, remove the 2 mylar screw covers (1) and the 2 Phillips 
PM2.0×3.0 screws (2) in the bottom corners of the display bezel.

10. Flex the top (3) of the bezel, the inside edges of the left and right sides (4), and then the bottom (5) of 
the bezel until it disengages from the display enclosure.

NOTE: Make sure the hinges are not bent (see hinge position in following image) when you remove the 
bezel.
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11. Remove the display bezel (6).

The display bezel is available using spare part number 768375-001 for models with a webcam and 
768376-001 for models without a webcam. Display bezel mylar screw covers are available in the Rubber 
Kit, spare part number 768387-001.

12. If it is necessary to replace the webcam or microphone module, gently pull the module away from the 
double-sided tape on the display enclosure (1), and then disconnect the cable from the module (2).

The webcam module is available using spare part number 767457-001. The microphone module is 
available using spare part number 773563-001.
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13. If it is necessary to remove the display panel from the enclosure, remove the 4 Phillips PM2.0×3.0 
screws (1) that secure the panel to the display enclosure, and then lift the top of the panel upward (2).

The raw display panel is available using spare part number 768386-001 for HD+, SVA, antiglare, flat 
panels and 810984-001 for FHD, WVA, antiglare panels.

14. Rotate the display panel all the way over (1), disconnect the display cable from the rear of the panel (2), 
and then remove the display panel (3) from the enclosure.

15. If it is necessary to replace the display hinges, remove the 6 Phillips PM2.0×3.0 screws (1) that secure 
the display hinges to the display enclosure.
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16. Lift the bottom of the hinges upward (2), pull the top of the hinges out from under the tabs (3), and then 
remove the display hinges from the display enclosure (4).

Display hinges are available in the Display Hinge Kit using spare part number 768379-001.

17. If it is necessary to replace the display/webcam cable, lift the display/webcam cable assembly straight 
up and off the display panel.

The display cable is available in the Cable Kit using spare part number 768377-001.
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18. If it is necessary to replace the WLAN antenna cables, lift them straight up and out of the display panel, 
noting their routing paths for reinstallation.

Reverse this procedure to reassemble and install the display assembly.

76 Chapter 6   Removal and replacement procedures for Authorized Service Provider parts



Power connector and cable

Description Spare part number

Power connector and cable 767432-001

Before removing the power cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the 
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and 
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 29).

5. Remove the following components:

a. Service doors (see Service door on page 30).

b. Keyboard (see Keyboard on page 40)

c. Hard drive (Hard drive on page 32)

d. Optical drive (Optical drive on page 36)

e. Top cover (see Top cover on page 44)

f. Display assembly (see Display assembly on page 70)

Remove the power cable:

1. Disconnect the cable from the bottom of the system board (1).
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2. Remove the cable from the clips built into the computer (2), and then lift the power cable from the 
computer (3).

Reverse this procedure to install the power cable.
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7 Computer Setup (BIOS) and MultiBoot in 
Windows 7

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and 
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup 
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of 
system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from 
operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB 
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard 
to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press 
enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, 
or use the up arrow key or the down arrow key on the keyboard.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and then 
follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Main > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and then 
follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing 
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the 
computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be revealed by pressing fn+esc (if 
you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select Main > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner of the 
screen, and then follow the on-screen instructions.

– or –
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and 
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do 
not download or install a BIOS update while the computer is running on battery power, docked in an optional 
USB docking device, or connected to an optional power source. During the download and installation, follow 
these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Access Help and Support by selecting Start > Help and Support.

2. Select Updates and tune-ups, and then select Check for HP updates now.

3. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on your 
computer. Make a note of the date, name, or other identifier. You may need this information to 
locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your hard 
drive where the BIOS update is downloaded. You will need to access this path when you are ready 
to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before installing 
any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download 
is complete. If no instructions are revealed, follow these steps:

1. Select Start > Computer.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the 
update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file 
from your hard drive.

Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is 
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include 

Using MultiBoot 81



optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices 
contain bootable media or files that the computer needs to start and operate properly.

NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the boot order.

You can change the order in which the computer searches for a boot device by changing the boot order in 
Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed 
at the bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot 
devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to 
prompt you for a boot location each time the computer turns on or restarts.

Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

● To set a new boot order that the computer uses each time it is turned on, by changing the boot order in 
Computer Setup.

● To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options 
menu.

● To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each 
time the computer is turned on or restarted.

Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or 
restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select the Legacy Boot Order list, and then press enter.

4. To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.

– or –

To move the device down in the boot order, use a pointing device to click the down arrow, or press the - 
key.

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen, 
and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc while 
the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press f9.

3. Use a pointing device or the arrow keys to select a boot device, then press enter.
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Setting a MultiBoot Express prompt

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the 
computer is started or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select System Configuration > Boot Options, and then press 
enter.

4. In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the 
computer to display the startup location menu before it defaults to the current MultiBoot setting. (When 
0 is selected, the Express Boot startup location menu is not displayed.)

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen, 
and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

● To specify a boot device from the Express Boot menu, select your preference within the allotted time, 
and then press enter.

● To prevent the computer from defaulting to the current MultiBoot setting, press any key before the 
allotted time expires. The computer will not start until you select a boot device and press enter.

● To allow the computer to start according to the current MultiBoot settings, wait for the allotted time to 
expire.
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8 Computer Setup (BIOS) and MultiBoot in 
Windows 8

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and 
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup 
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of 
system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from 
operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB 
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard 
to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press 
enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, 
or use the up arrow key or the down arrow key on the keyboard.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and then 
follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Main > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and then 
follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing 
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the 
computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be revealed by pressing fn+esc (if 
you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select Main > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner of the 
screen, and then follow the on-screen instructions.

– or –
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and 
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do 
not download or install a BIOS update while the computer is running on battery power, docked in an optional 
USB docking device, or connected to an optional power source. During the download and installation, follow 
these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type hp support assistant, and then select the HP Support Assistant app.

2. Click Updates and tune-ups, and then click Check for HP updates now.

3. Follow the on-screen instructions.

4. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on your 
computer. Make a note of the date, name, or other identifier. You may need this information to 
locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your hard 
drive where the BIOS update is downloaded. You will need to access this path when you are ready 
to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before installing 
any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download 
is complete. If no instructions are revealed, follow these steps:

1. From the Start screen, type file, and then select File Explorer.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the 
update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file 
from your hard drive.
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Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is 
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include 
optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices 
contain bootable media or files that the computer needs to start and operate properly.

NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the boot order.

You can change the order in which the computer searches for a boot device by changing the boot order in 
Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed 
at the bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot 
devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to 
prompt you for a boot location each time the computer turns on or restarts.

Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

● To set a new boot order that the computer uses each time it is turned on, by changing the boot order in 
Computer Setup.

● To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options 
menu.

● To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each 
time the computer is turned on or restarted.

Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or 
restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select one of the following options:

● Advanced > Boot Options > UEFI Boot Order > UEFI Hybrid

● Advanced > Boot Options > UEFI Boot Order > UEFI Native Boot mode

● Advanced > Boot Options > Legacy Boot Order > Legacy Boot Mode

Press enter.

4. To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.

– or –

Using MultiBoot 87



To move the device down in the boot order, use a pointing device to click the down arrow, or press the - 
key.

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen, 
and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc while 
the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press f9.

3. Use a pointing device or the arrow keys to select a boot device, then press enter.

Setting a MultiBoot Express prompt

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the 
computer is started or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Advanced > Boot Options > MultiBoot Express Boot 
Popup Delay (Sec), and then press enter.

4. In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the 
computer to display the startup location menu before it defaults to the current MultiBoot setting. (When 
0 is selected, the Express Boot startup location menu is not displayed.)

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen, 
and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

● To specify a boot device from the Express Boot menu, select your preference within the allotted time, 
and then press enter.

● To prevent the computer from defaulting to the current MultiBoot setting, press any key before the 
allotted time expires. The computer will not start until you select a boot device and press enter.

● To allow the computer to start according to the current MultiBoot settings, wait for the allotted time to 
expire.
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9 Computer Setup (BIOS), TPM, and HP Sure 
Start in Windows 10

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and 
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup 
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of 
system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from 
operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB 
legacy support is enabled.

To start Computer Setup, follow these steps:

▲ Start Computer Setup.

● Computers or tablets with keyboards:

▲ Turn on or restart the computer, and when the HP logo appears, press f10 to enter Computer 
Setup.

● Tablets without keyboards:

▲ Turn off the tablet. Press the power button in combination with the volume down button until 
the Startup menu is displayed, and then tap F10 to enter Computer Setup.

Navigating and selecting in Computer Setup

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or 
use a pointing device to select the item.

NOTE: On tablets without keyboards, you can use your finger to make selections.

● To scroll up and down, select the up arrow or the down arrow in the upper-right corner of the screen, or 
use the up arrow key or the down arrow key on the keyboard.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow 
the on-screen instructions.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Select the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –

Select Main, select Ignore Changes and Exit, and then press enter.

● To save your changes and exit Computer Setup menus:

Select the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –

Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Start Computer Setup. See Starting Computer Setup on page 89.

2. Select Main, and then select Apply Factory Defaults and Exit.

NOTE: On select products, the selections may display Restore Defaults instead of Apply Factory 
Defaults and Exit.

3. Follow the on-screen instructions.

4. To save your changes and exit, select the Save icon in the lower-right corner of the screen, and then 
follow the on-screen instructions.

– or –

Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing 
and troubleshooting the file.

Determining the BIOS version

To decide whether you need to update Computer Setup (BIOS), first determine the BIOS version on your 
computer.

BIOS version information (also known as ROM date and System BIOS) can be accessed by pressing fn+esc (if 
you are already in Windows) or by using Computer Setup.

1. Start Computer Setup. See Starting Computer Setup on page 89.

2. Select Main, and then select System Information.

3. To exit Computer Setup without saving your changes, select the Exit icon in the lower-right corner of the 
screen, and then follow the on-screen instructions.

– or –

Select Main, select Ignore Changes and Exit, and then press enter.

To check for later BIOS versions, see Downloading a BIOS update on page 91.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and 
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do 
not download or install a BIOS update while the computer is running on battery power, docked in an optional 
docking device, or connected to an optional power source. During the download and installation, follow these 
instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Type support in the taskbar search box, and then select the HP Support Assistant app.

– or –

Select the question mark icon in the taskbar.

2. Select Updates, and then select Check for updates and messages.

3. Follow the on-screen instructions.

4. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on your 
computer. Make a note of the date, name, or other identifier. You may need this information to 
locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is downloaded. 
You will need to access this path when you are ready to install the update.
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NOTE: If you connect your computer to a network, consult the network administrator before installing 
any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download 
is complete. If no instructions are revealed, follow these steps:

1. Type file in the taskbar search box, and then select File Explorer.

2. Select your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder that contains the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file 
from your hard drive.

Changing the boot order using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Access the Boot Device Options menu:

● Computers or tablets with keyboards:

▲ Turn on or restart the computer, and when the HP logo appears, press f9 to enter the Boot 
Device Options menu.

● Tablets without keyboards:

▲ Turn off the tablet. Press the power button in combination with the volume down button until 
the Startup menu is displayed, and then tap F9 to enter the Boot Device Options menu.

2. Select a boot device, then press enter.

TPM BIOS settings (select products only) 
IMPORTANT: Before enabling Trusted Platform Module (TPM) functionality on this system, you must ensure 
that your intended use of TPM complies with relevant local laws, regulations and policies, and approvals or 
licenses must be obtained if applicable. For any compliance issues arising from your operation/usage of TPM 
which violates the above mentioned requirement, you shall bear all the liabilities wholly and solely. HP will 
not be responsible for any related liabilities.

TPM provides additional security for your computer. You can modify the TPM settings in Computer Setup 
(BIOS).

NOTE: If you change the TPM setting to Hidden, TPM is not visible in the operating system. 

To access TPM settings in Computer Setup:

1. Start Computer Setup. See Starting Computer Setup on page 89.

2. Select Security, select TPM Embedded Security, and then follow the on-screen instructions.
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Using HP Sure Start (select products only)
Select computer models are configured with HP Sure Start, a technology that continuously monitors the 
computer's BIOS for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start 
automatically restores the BIOS to its previously safe state, without user intervention.

HP Sure Start is configured and already enabled so that most users can use the HP Sure Start default 
configuration. The default configuration can be customized by advanced users.

To access the latest documentation on HP Sure Start, go to http://www.hp.com/support, and select your 
country. Select Drivers & Downloads, and then follow the on-screen instructions.
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10 Computer Setup (BIOS) in Ubuntu Linux

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and 
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup 
includes settings for the types of peripherals installed, the startup sequence of the computer, and the 
amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from 
operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB 
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press 
enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, 
or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and then 
follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard 
to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner 
of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.
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– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Main > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow 
the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing 
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the 
computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be revealed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select Main > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.
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NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing the esc 
key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and 
then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and 
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do 
not download or install a BIOS update while the computer is running on battery power, docked in an optional 
docking device, or connected to an optional power source. During the download and installation, follow these 
instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For worldwide 
support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want to 
download.

3. Click the option for software and driver downloads, type your computer model number in the product 
box, and then press enter. Follow the on-screen instructions to identify your computer and access the 
BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file 
from your hard drive.
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11 HP PC Hardware Diagnostics (UEFI)

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run diagnostic 
tests to determine whether the computer hardware is functioning properly. The tool runs outside the 
operating system so that it can isolate hardware failures from issues that are caused by the operating system 
or other software components.

NOTE: To start BIOS on a convertible computer, your computer must be in notebook mode and you must use 
the keyboard attached to your tablet. The on-screen keyboard, which displays in tablet mode, cannot access 
BIOS.

To start HP PC Hardware Diagnostics UEFI:

1. Start BIOS:

● Computers or tablets with keyboards:

▲ Turn on or restart the computer, quickly press esc.

● Tablets without keyboards:

▲ Turn on or restart the tablet, and then quickly hold down the volume down button.

- or -

Turn on or restart the tablet, and then quickly hold down the Windows button.

2. Press or tap f2.

The BIOS searches three places for the diagnostic tools, in the following order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading 
HP PC Hardware Diagnostics (UEFI) to a USB device on page 97.

b. Hard drive

c. BIOS

3. When the diagnostic tool opens, select the type of diagnostic test you want to run, and then follow the 
on-screen instructions. On a tablet, press the volume down button to stop a diagnostic test.

NOTE: If you need to stop a diagnostic test on computers or tablets with a keyboard, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
There are two options to download HP PC Hardware Diagnostics to a USB device:

Download the latest UEFI version: 

1. Go to http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2. In the HP PC Hardware Diagnostics section, click the Download link, and then select Run.
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Download any version of UEFI for a specific product: 

1. Go to http://www.hp.com/support, and then select your country. The HP Support page is displayed.

2. Click Drivers & Downloads.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer, and then select your operating system.

5. In the Diagnostic section,  follow the on-screen instructions to select and download the UEFI version 
you want.
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12 Backup and recovery in Windows 7

Your computer includes HP and Windows tools to help you safeguard your information and retrieve it if you 
ever need to. These tools will help you return your computer to a proper working state, all with simple steps. 
This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create HP Recovery media. This step creates a Windows 7 
operating system DVD and a Driver Recovery DVD. The Windows DVD can be used to reinstall the original 
operating system in cases where the hard drive is corrupted or has been replaced. The Driver Recovery 
DVD installs specific drivers and applications. See Creating recovery media with HP Recovery Disc 
Creator on page 99.

2. Use Windows Backup and Recovery tools to perform the following:

● Back up individual files and folders

● Back up your entire hard drive (select models only)

● Create system repair discs (select models only) with the installed optical drive (select models only) 
or an optional external optical drive

● Create system restore points

NOTE: This guide describes an overview of backing up, restoring, and recovering options. For more details 
about the tools provided, see Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of 
system instability.

In case of system failure, you can use the backup files to restore the contents of your computer. See Backing 
up your information on page 100.

Guidelines

● When creating recovery media or backing up to discs, use any of the following types of discs (purchased 
separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the type 
of optical drive you are using.

● Be sure that the computer is connected to AC power before you start the recovery media creation 
process or the backup process.

Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery media. After 
you successfully set up the computer, you can create recovery media using HP Recovery Disc Creator. This 
recovery media allows you to reinstall your original operating system as well as select drivers and 
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applications if the hard drive becomes corrupted. HP Recovery Disc Creator can create two kinds of recovery 
DVDs:

● Windows 7 operating system DVD—Installs the operating system without additional drivers or 
applications.

● Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP 
Software Setup utility installs drivers and applications.

Creating recovery media

NOTE: The Windows 7 operating system DVD can be created only once. Thereafter, the option to create that 
media will not be available after you create a Windows DVD.

To create the Windows DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Windows disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process.

Backing up your information

You should create system repair media and your initial backup immediately after initial system setup. As you 
add new software and data files, you should continue to back up your system on a regular basis to maintain a 
reasonably current backup. You should also create Windows system repair media (select models only) which 
can be used to start up (boot) the computer and repair the operating system in case of system instability or 
failure. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated directories.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your 
settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in 
Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: Windows includes the User Account Control feature to improve the security of your computer. You 
may be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and 
Support.
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To create a backup using Windows Backup and Restore:

NOTE: The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models only), or 
create system repair media (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you have 
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent 
Windows from starting correctly.

● f11 recovery tools (select models only): You can use the f11 recovery tools to recover your original hard 
drive image. The image includes the Windows operating system and software programs installed at the 
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair media you 
previously created (select models only), you must purchase Windows 7 operating system media to reboot the 
computer and repair the operating system. For additional information, see Using Windows 7 operating system 
media on page 102.

Using the Windows recovery tools 

Using the Windows recovery tools, you can:

● Recover individual files

● Restore the computer to a previous system restore point

● Recover information using recovery tools

NOTE: For detailed instructions on various recovery and restore options, perform a search for these topics 
in Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: Windows includes the User Account Control feature to improve the security of your computer. You 
may be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and 
Support.

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models only), 
or your files.

To recover your information using Startup Repair, follow these steps:

CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files you have 
created and any software installed on the computer are permanently removed. When reformatting is 
complete, the recovery process restores the operating system, as well as the drivers, software, and utilities 
from the backup used for recovery.

Performing a system recovery 101



1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.

NOTE: If the Windows partition is not listed, you must recover your operating system and programs 
using the Windows 7 operating system DVD and the Driver Recovery media. For additional information, 
see Using Windows 7 operating system media on page 102.

3. If the Windows partition is listed, restart the computer, and then press f8 before the Windows operating 
system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, select Start > Help 
and Support.

Using f11 recovery tools (select models only)

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you 
have created and any software that you have installed on the computer are permanently removed. The f11 
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory. 
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer, click 
Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and programs 
using the Windows 7 operating system media and the Driver Recovery media. For additional information, 
see Using Windows 7 operating system media on page 102.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the ESC 
key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 7 operating system media

If you cannot use the recovery media you previously created using the HP Recovery Disc Creator (select 
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and repair the 
operating system.

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to 
http://www.hp.com/support. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the 
Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and reformats 
the hard drive. All files that you have created and any software that you have installed on the computer are 
permanently removed. When reformatting is complete, the recovery process helps you restore the operating 
system, as well as drivers, software, and utilities.
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To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before 
the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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13 Backup and recovery in Windows 8

To protect your information, use Windows backup and restore utilities to back up individual files and folders, 
back up your entire hard drive, create system repair media (select models only) by using the installed optical 
drive (select models only) or an optional external optical drive, or create system restore points. In case of 
system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in 
Windows Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later 
use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer. You 
may be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. For more information, see Windows Help and Support.

Backing up your information
Recovery after a system failure is as good as your most recent backup. You should create system repair media 
and your initial backup immediately after initial system setup. As you add new software and data files, you 
should continue to back up your system on a regular basis to maintain a reasonably current backup.

For more information on the Windows backup features, see Windows Help and Support.

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you have 
previously backed up. You can also use Windows Automatic Repair to fix problems that might prevent 
Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The 
image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair media you 
previously created (select models only), you must purchase Windows operating system media to reboot the 
computer and repair the operating system. For additional information, see Using Windows operating system 
media (purchased separately) on page 106.

Using the Windows recovery tools

To recover information you previously backed up, see Windows Help and Support for steps on restoring files 
and folders.

To recover your information using Automatic Repair, follow these steps:
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CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files you have 
created and any software installed on the computer are permanently removed. When reformatting is 
complete, the recovery process restores the operating system, as well as the drivers, software, and utilities 
from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition and the Windows partition.

From the Start screen, type file, and then click File Explorer.

– or –

From the Start screen, type pc, and then select This PC.

NOTE: If the Windows partition and the Recovery Image partition are not listed, you must recover your 
operating system and programs using the Windows operating system DVD and the Driver Recovery 
media (both purchased separately). For additional information, see Using Windows operating system 
media (purchased separately) on page 106.

3. If the Windows partition and the Recovery Image partition are listed, restart the computer by pressing 
and holding the shift key while clicking Restart.

4. Select Troubleshoot, then select Advanced Options, and then select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a search for 
these topics in Windows Help and Support.

Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you 
have created and any software that you have installed on the computer are permanently removed. The f11 
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory. 
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition: From the Start screen, type pc, and 
then select This PC.

NOTE: If the Recovery Image partition is not listed, you must recover your operating system and 
programs using the Windows operating system media and the Driver Recovery media (both purchased 
separately). For additional information, see Using Windows operating system media (purchased 
separately) on page 106.

3. If the Recovery Image partition is listed, restart the computer, and then press esc while the “Press the 
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using Windows operating system media (purchased separately)

To order a Windows operating system DVD, contact support. See the Worldwide Telephone Numbers booklet 
included with the computer. You can also find contact information from the HP website. Go to 
http://www.hp.com/support, select your country or region, and follow the on-screen instructions.

CAUTION: Using a Windows operating system media completely erases hard drive contents and reformats 
the hard drive. All files that you have created and any software that you have installed on the computer are 
permanently removed. When reformatting is complete, the recovery process helps you restore the operating 
system, as well as drivers, software, and utilities.

To initiate a full install of the operating system using a Windows operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Insert the Windows operating system DVD into the optical drive, and then restart the computer.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the installation is completed:

1. Eject the Windows operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh or Windows Reset

When your computer is not working properly and you need to regain system stability, the Windows Refresh 
option allows you to start fresh and keep what is important to you.

The Windows Reset option allows you to perform detailed reformatting of your computer, or remove personal 
information before you give away or recycle your computer. For more information on these features, see 
Windows Help and Support.

Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted from 
the system.

1. From the Start screen, type HP Software Setup.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.
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14 Backup and recovery in Windows 10

This chapter provides information about the following processes. The information in the chapter is standard 
procedure for most products.

● Creating recovery media and backups

● Restoring and recovering your system

For additional information, refer to the HP support assistant app.

▲ Type support in the taskbar search box, and then select the HP Support Assistant app.

‒ or –

Click the question mark icon in the taskbar.

IMPORTANT: If you will be performing recovery procedures on a tablet, the tablet battery must be at least 
70% charged before you start the recovery process.

IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before 
beginning any recovery process.

Creating recovery media and backups
The following methods of creating recovery media and backups are available on select products only. Choose 
the available method according to your computer model.

● Use HP Recovery Manager to create HP Recovery media after you successfully set up the computer. This 
step creates a backup of the HP Recovery partition on the computer. The backup can be used to reinstall 
the original operating system in cases where the hard drive is corrupted or has been replaced. For 
information on creating recovery media, see Creating HP Recovery media (select products only) 
on page 107. For information on the recovery options that are available using the recovery media, see 
Using Windows tools on page 108.

● Use Windows tools to create system restore points and create backups of personal information. 

For more information, see Recovering using HP Recovery Manager on page 109.

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

Creating HP Recovery media (select products only)

If possible, check for the presence of the Recovery partition and the Windows partition. From the Start menu, 
select File Explorer, and then select This PC.

● If your computer does not list the Windows partition and the Recovery partition, you can obtain recovery 
media for your system from support. See the Worldwide Telephone Numbers booklet included with the 
computer. You can also find contact information on the HP website. Go to http://www.hp.com/support, 
select your country or region, and follow the on-screen instructions.
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You can use Windows tools to create system restore points and create backups of personal information, 
see Using Windows tools on page 108.

● If your computer does list the Recovery partition and the Windows partition, you can use HP Recovery 
Manager to create recovery media after you successfully set up the computer. HP Recovery media can be 
used to perform system recovery if the hard drive becomes corrupted. System recovery reinstalls the 
original operating system and software programs that were installed at the factory and then configures 
the settings for the programs. HP Recovery media can also be used to customize the system or restore 
the factory image if you replace the hard drive.

◦ Only one set of recovery media can be created. Handle these recovery tools carefully, and keep 
them in a safe place.

◦ HP Recovery Manager examines the computer and determines the required storage capacity for 
the media that will be required.

◦ To create recovery discs, your computer must have an optical drive with DVD writer capability, and 
you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use 
rewritable discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray) 
discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a high-
quality blank USB flash drive. 

◦ If your computer does not include an integrated optical drive with DVD writer capability, but you 
would like to create DVD recovery media, you can use an external optical drive (purchased 
separately) to create recovery discs. If you use an external optical drive, it must be connected 
directly to a USB port on the computer; the drive cannot be connected to a USB port on an external 
device, such as a USB hub. If you cannot create DVD media yourself, you can obtain recovery discs 
for your computer from HP. See the Worldwide Telephone Numbers booklet included with the 
computer. You can also find contact information on the HP website. Go to http://www.hp.com/
support, select your country or region, and follow the on-screen instructions.

◦ Be sure that the computer is connected to AC power before you begin creating the recovery media.

◦ The creation process can take an hour or more. Do not interrupt the creation process.

◦ If necessary, you can exit the program before you have finished creating all of the recovery DVDs. 
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery 
Manager, you will be prompted to continue.

To create HP Recovery media:

IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before 
beginning these steps.

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.

2. Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 109.

Using Windows tools
You can create recovery media, system restore points, and backups of personal information using Windows 
tools. 

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see the Get started app.

▲ Select the Start button, and then select the Get started app.
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Restore and recovery
There are several options for recovering your system. Choose the method that best matches your situation 
and level of expertise:

IMPORTANT: Not all methods are available on all products.

● Windows offers several options for restoring from backup, refreshing the computer, and resetting the 
computer to its original state. For more information see the Get started app.

▲ Select the Start button, and then select the Get started app.

● If you need to correct a problem with a preinstalled application or driver, use the Reinstall drivers and/or 
applications option (select products only) of HP Recovery Manager to reinstall the individual application 
or driver.

▲ Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers 
and/or applications, and then follow the on-screen instructions.

● If you want to recover the Windows partition to original factory content, you can choose the System 
Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media. 
For more information, see Recovering using HP Recovery Manager on page 109. If you have not already 
created recovery media, see Creating HP Recovery media (select products only) on page 107.

● On select products, if you want to recover the computer's original factory partition and content, or if you 
have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more 
information, see Recovering using HP Recovery Manager on page 109.

● On select products, if you want to remove the recovery partition to reclaim hard drive space, HP 
Recovery Manager offers the Remove Recovery Partition option.

For more information, see Removing the HP Recovery partition (select products only) on page 112.

Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state by using the 
HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery 
partition (select products only). If you have not already created recovery media, see Creating HP Recovery 
media (select products only) on page 107.

What you need to know before you get started

● HP Recovery Manager recovers only software that was installed at the factory. For software not provided 
with this computer, you must either download the software from the manufacturer's website or reinstall 
the software from the media provided by the manufacturer.

IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct 
computer issues.

● HP Recovery media must be used if the computer hard drive fails. If you have not already created 
recovery media, see Creating HP Recovery media (select products only) on page 107.

● To use the Factory Reset option (select products only), you must use HP Recovery media. If you have not 
already created recovery media, see Creating HP Recovery media (select products only) on page 107.

● If your computer does not allow the creation of HP Recovery media or if the HP Recovery media does not 
work, you can obtain recovery media for your system from support. See the Worldwide Telephone 
Numbers booklet included with the computer. You can also find contact information from the HP 
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website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen 
instructions.

IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before 
beginning recovery, back up any personal data you want to retain.

Using HP Recovery media, you can choose from one of the following recovery options:

NOTE: Only the options available for your computer display when you start the recovery process.

● System Recovery—Reinstalls the original operating system, and then configures the settings for the 
programs that were installed at the factory.

● Factory Reset—Restores the computer to its original factory state by deleting all information from the 
hard drive and re-creating the partitions. Then it reinstalls the operating system and the software that 
was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.

Using the HP Recovery partition (select products only)

The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a 
recovery USB flash drive. This type of recovery can be used only if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:

IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before 
beginning these steps (select products only).

1. Type recovery in the taskbar search box, select Recovery Manager, and then select HP Recovery 
Environment.

- or-

For computers or tablets with keyboards attached, press f11 while the computer boots, or press and 
hold f11 as you press the power button.

For tablets without keyboards:

Turn on or restart the tablet, and then quickly hold down the volume down button; then select f11.

- or -

Turn on or restart the tablet, and then quickly hold down the Windows button; then select f11.

2. Select Troubleshoot from the boot options menu.

3. Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system does 
not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.

2. Insert the HP Recovery media, and then restart the computer.

NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer 
boot order. See Changing the computer boot order on page 111.

3. Follow the on-screen instructions.
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Changing the computer boot order

If your computer does not restart in HP Recovery Manager, you can change the computer boot order, which is 
the order of devices listed in BIOS where the computer looks for startup information. You can change the 
selection to an optical drive or a USB flash drive.

To change the boot order:

IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before 
beginning these steps.

1. Insert the HP Recovery media.

2. Access BIOS:

For computers or tablets with keyboards attached:

▲ Turn on or restart the computer or tablet, quickly press esc, and then press f9 for boot options.

For tablets without keyboards:

▲ Turn on or restart the tablet, and then quickly hold down the volume down button; then select f9.

- or -

Turn on or restart the tablet, and then quickly hold down the Windows button; then select f9.

3. Select the optical drive or USB flash drive from which you want to boot.

4. Follow the on-screen instructions.

Restore and recovery 111



Removing the HP Recovery partition (select products only)

HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.

IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery 
or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition, 
create HP Recovery media; see Creating HP Recovery media (select products only) on page 107.

NOTE: The Remove Recovery Partition option is only available on products that support this function.

Follow these steps to remove the HP Recovery partition:

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.
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15 Backup and Recovery in Ubuntu Linux

Recovery after a system failure is as good as your most recent backup. As you add new software and data 
files, you should continue to back up your system on a regular basis to maintain a reasonably current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if ever 
needed.

Creating backups
1. Create restore media immediately after you set up the computer. For more information, see Performing 

a system recovery on page 114.

2. As you add files, routinely create a backup of your system and personal information.

Backing up your information
You should back up your computer files on a regular schedule to maintain a current backup. You can manually 
back up your information to an optional external drive, a network drive, or discs. Back up your system at the 
following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click Backup my home 
directory.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled time.

To immediately back up your information, click the Backup Now check box.

NOTE: Before you back up your information, be sure you have designated a location to save the 
backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.

4. To restore all files from the selected location, click Restore all files. To restore select files only, click 
Restore selected files, click Select Files and then select the files to be restored.

5. Under Restore Point, click the time and date of the backup.
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NOTE: If multiple backups have been performed, click Use the latest version to restore the latest 
version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery
Recovery allows you to repair or restore the computer to its original factory state. You can create an HP 
Factory Image, using an installed or an external DVD±RW optical drive.

NOTE: Your computer may not come equipped with an internal optical drive. In order to create the HP 
Factory Image, you may need to plug in an external optical drive.

CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All files you 
have created and any software installed on the computer are permanently removed. The recovery tool 
reinstalls the original operating system and HP programs and drivers that were installed at the factory. 
Software, drivers, and updates not installed by HP must be manually reinstalled. Personal files must be 
restored from a backup.

To restore the computer using the HP Factory Image, you must first create the recovery ISO file and then burn 
it to an optical disc.

NOTE: HP recommends that you create the HP Factory Image in the event of a system failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image in the right pane.

3. Enter the root password when prompted.

4. Right-click on the HP_Recovery.iso file and select Open with Brasero.

5. Insert a blank DVD disc and select Burn. This creates the HP Factory Image Restore DVD.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu.

4. Select Optical Disk Drive from the Boot Options menu and press enter.

5. Press enter to select Restore System from Media.

6. At both of the System Recovery prompts, select Yes.

USB Recovery option (select models only)
The USB Recovery Disk On Key (flash drive) option allows you to create a backup image of the Ubuntu 
operating system installed on select HP Business Notebooks. This Disk On Key may be used to restore the 
system to the original factory state when the F11 recovery option is not available. This process should be 
done on first obtaining the computer.

CAUTION: The USB recovery option does not preserve data present on the computer’s hard drive or on the 
Disk On Key used for the recovery process. Back up any data on the Disk on Key or the notebook that will be 
recovered before starting.
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NOTE: HP recommends that you create the USB Recovery Disk in the event of a system failure. The Disk On 
Key used for this process should be 4 GB or larger.

Creating a USB Recovery Disk On Key

1. Connect the USB Disk On Key to a USB port on the computer.

2. Select Computer > More applications > Tools > Create Recovery USB.

3. Enter the root password when prompted.

4. Select USB Disk On Key from the list.

5. Click OK.

6. A question dialog will remind you that the data on the USB key will be destroyed. To continue, click OK. 
Otherwise, click Cancel and back up the contents of the Disk On Key on another computer.

7. The backup process will display a status dialog box while the backup is in progress.

NOTE: A file browser window with the Disk On Key Contents displayed will pop up when the key is 
mounted. You may close the file browser window if desired. Once the USB Recovery Key has been 
created, the status dialog will close. The USB Recovery Key is ready for use.

Recovering from a USB Recovery Disk On Key

CAUTION: Before starting the Recovery process, make sure any data on the system to be recovered has 
been backed up. The recovery process destroys all data on the system to be recovered.

1. Turn off the computer.

2. Connect the USB Disk On Key to a USB port on the computer.

3. Turn on the computer while holding down the f9 key.

4. Once the system has booted, the Boot Options menu should appear.

5. Using the arrow keys, select USB Disk On Key and press enter.

NOTE: The description may vary from one USB key to another. Any entry other than Optical Disk Drive, 
Notebook Hard Drive or Notebook Ethernet should be the USB Recovery Disk On Key.

6. Once the USB Recovery Disk On Key has been selected, press enter. The USB Recovery Disk On Key will 
boot.

7. Once the USB Recovery Disk On Key has booted, a dialog box will prompt, “Do you want to start the 
System-Restore?” If data on the computer has not been backed up, use the tab key and select No. The 
system will reboot. Back up the system data and repeat the previous steps. If no data should be saved 
from the computer, use the tab key to select Yes. Press enter to begin the recovery process.

8. After the files are copied to the system, follow the on-screen instructions.

Remove everything and reinstall Ubuntu
Sometimes you want to perform detailed reformatting of your computer, or you want to remove personal 
information before you give away or recycle your computer. The process described in this section provides a 
speedy, simple way to return the computer to its original state. This option removes all personal data, 
applications, and settings from your computer, and reinstalls the Linux operating system.

IMPORTANT: This option does not provide backups of your information. Before using this option, back up 
any personal information you wish to retain.
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You can initiate this option by using the f11 key.

To use the f11 key:

Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

The following options are available:

● Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

● Recover/Repair System—This option repairs a system that is not working properly and preserves user 
data.

● Restore Factory System—This option restores the system back to the original factory state. User data is 
not preserved.

Select an option and follow the on-screen instructions.
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16 Specifications

Computer specifications

 Metric U.S.

Dimensions

Length

279.5 mm 11.00 in

Width 413.8 mm 16.29 in

Height (front to rear)

26.0 to 32.2 mm 1.02 to 1.27 in

Weight

Non-touchscreen (equipped with 1 DIMM, SSD, WLAN module, 
webcam, 6 cell battery, optical drive)

2.92 kg 6.45 lbs

Non-touchscreen (equipped with 1 DIMM, SSD, WLAN module, 
webcam, 6 cell battery, no optical drive)

2.81 kg 6.21 lbs

Non-touchscreen (equipped with 1 DIMM, hard drive, WLAN 
module, webcam, 6 cell battery, optical drive)

2.95 kg 6.52 lbs

Non-touchscreen (equipped with 1 DIMM, hard drive, WLAN 
module, webcam, 6 cell battery, no optical drive)

2.84 kg 6.28 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 90 W or 18.5 V dc @ 3.5 A - 65 W

Operating current 4.74 A or 3.5 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m 50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine
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 Metric U.S.

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this range 
of temperatures.

43.9-cm (17.3-in), HD+ display specifications

 Metric U.S.

Active diagonal size 43.9-cm 17.3-in

Resolution 1600x900 (HD+) or 1920x1080 (FHD)

Surface treatment Anti-glare

Contrast ratio 200:1 (typical)

Brightness 200 nits (HD+) or 300 nits (FHD)

Viewing angle SVA (HD+) or WVA (FHD)

Backlight LED

Pixel configuration RGB vertical stripe

Pixel pitch 0.2388x0.2388 (WxH)

Active area 382.08x214.92 (WxH)

Weight 540 g (typical)
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Hard drive specifications

 1.5-TB* 1-TB* 750-GB* 500-GB* 500-GB* 
hybrid

320-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm or 7.0 
mm

7.0 mm 7.0 mm

Width 70 mm 70 mm 70 mm 70 mm 70 mm 70 mm

Weight 118 g 115 g 102 g 101 g or 95 g 95 g 95 g

Interface type SATA SATA SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 2.2 ms 1.4 ms 1.1 ms 3 ms 2 ms 1.1 ms

Average 13 ms 10 ms 12 ms 13 ms 12 ms 13 ms

Maximum 25 ms 12 ms 21 ms 24 ms 22 ms 25 ms

Logical blocks 2,930,277,168 1,938,921,461 1,465,149,168 1,048,576,000 976,773,168 625,141,400

Disc rotational speed
5400 rpm 5400 rpm

7200 or 5400 
rpm

7200 rpm or 
5400 rpm

5400 rpm 5400 rpm

Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications may 
differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Solid-state drive specifications

 128-GB*

Height 7.0 mm

Weight < 50 g

Form factor 2.5-inch

Transfer rate up to 515 MB/sec

Interface type SATA-3

Ready time, maximum (to not busy) < 1.0 ms

Access times, logical 0.1 ms

Total logical sectors 250,069,680

Operating temperature  

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications may 
differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW SuperMulti DL Drive specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-
ROM XA, MIXED MODE CD, CD-I, CD-I Bridge (Photo-
CD, Video CD), Multisession CD (Photo-CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, 
DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-
R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-RW, 
DVD-RAM

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 175 ms < 230 ms

Full stroke < 285 ms < 335 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode

Startup time < 15 seconds

Stop time < 6 seconds
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Blu-ray ROM DVD±RW SuperMulti DL Drive

Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CDTEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I, 
CD-I Bridge (Photo-CD, Video CD), 
Multisession CD (Photo-CD, CD-EXTRA, 
Portfolio, CD-R, CD-RW), CD-R, CD-RW, 
DVDROM (DVD-5, DVD-9, DVD-10, 
DVD-18), DVD-R, DVD-RW, DVD+R, DVD
+RW, DVD-RAM, HD-ROM (Single Layer), 
HD-ROM (Dual Layer), HD DVD-R, HD DVD-
R for Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9), DVD
+RW, DVD-R, DVD-R(9),DVD-RW, DVD-RAM

Access time CD DVD HD

Random 170 ms 170 ms 230 ms

Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

1X BD-ROM 4,500 KB/sec

1X BD-R read 4,500 KB/sec

1X BD-RE read 4,500 KB/sec

Transfer mode Multiword DMA Mode

DVD-ROM drive

Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital Audio, 
CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form 2), CD-R, CD-
RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter 1.5 cm (0.59 in)

Disc diameter  

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)
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Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 μm

Access time CD DVD

Random < 100 ms < 125 ms

Full Stroke < 175 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3,600 KB/sec

DVD (8X) 3600 KB/s (150 KB/s at 1X CD rate)

Multiword DMA mode 2 16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds

Specification information in Device Manager
Device Manager allows you to view and control the hardware attached to the computer, as well as provides 
hardware specification information.

You can also add hardware or modify device configurations using Device Manager.

NOTE: Windows 7 includes the User Account Control feature to improve the security of your computer. You 
may be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to Windows Help and Support for more information.

After you open Device Manager, drill-down to a device and double-click it to access its properties.

To access Device Manager in Windows 8:

1. From the Start screen, type control, and then select Control Panel.

2. Select System and Security, and then in the System area, click Device Manager.

A list display all the devices installed in your computer.

To access Device Manager in Windows 7:

1. Select Start > Computer > System properties.

2. In the left pane, click Device Manager.
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17 Statement of Volatility

The purpose of this document is to provide general information regarding non-volatile memory in industry-
standards based HP Business Notebook PC systems and provide general instructions for restoring nonvolatile 
memory that can contain personal data after the system has been powered off and the hard drive has been 
removed.

HP Business Notebook PC products that use Intel®-based or AMD®-based system boards contain volatile DDR 
memory. The amount of nonvolatile memory present in the system depends upon the system configuration. 
Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally shipped 
from HP assuming that no subsequent modifications have been made to the system and assuming that no 
applications, features, or functionality have been added to or installed on the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC system, 
personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain 
in nonvolatile memory. The steps below will remove personal data from the notebook PC, including the 
nonvolatile memory found in Intel-based and AMD-based system boards. Some of these steps are disclosed 
in the Maintenance & Service Guides available for HP PC products available on the product support pages at 
www.hp.com.

1. Follow steps (a) through (I) below to restore the nonvolatile memory that can contain personal data. 
Restoring or reprogramming nonvolatile memory that does not store personal data is neither necessary 
nor recommended.

a. Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near the 
bottom of the display, or press the ESC key to display the start up menu, then press F10 . If the 
system has a BIOS administrator password, enter the password at the prompt.

b. Select the File menu, then Restore Defaults.

c. Select the System Configuration menu, then Restore Security Defaults.

d. If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities menu. 
Select System IDs, and then select the tag that has been set. Press the spacebar once to clear the 
tag, then press Enter to return to the prior menu.

e. If a DriveLock password is set, select the Security menu, scroll down to DriveLock, then select 
DriveLock password. Select the desired hard drive. Click Disable protection, enter the existing 
master DriveLock password, then press Enter to confirm and return to the prior menu. Repeat this 
procedure if more than one hard drive has a DriveLock password.

f. If an Automatic DriveLock password is set, select the Security menu, scroll down to Automatic 
DriveLock, then select the desired hard drive and disable protection. Repeat this procedure if more 
than one hard drive has an Automatic DriveLock password.

g. Select the File menu, then Reset BIOS Security to factory default. Click yes at the warning 
message.

h. Select the File menu, then Save Changes and Exit.

i. Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint sensor, 
one or two prompts will appear. One to clear the TPM and the other to Reset Fingerprint Sensor; 
press F1 to accept or F2 to reject.

If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel® Centrino with VProTM, 
reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select System Configuration, 
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then AMT Options. Then select Unconfigure AMT on next boot. Select Save then Yes. Select the 
File menu, and then select Save Changes and Exit. Reboot the system and confirm that you want 
to unconfigure AMT.

j. If the optional Intel® Anti-Theft Technology (AT) was activated, contact the provider to deactivate 
it.

k. If the optional Absolute® Software Computrace® management and tracking service was activated 
on the notebook PC, contact the provider to deactivate it.

l. Remove all power and system batteries for at least 24 hours.

2. Remove and retain the storage drive or clear the contents of the drive.

a. Hard Disk Drive (HDD)

Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application that, 
ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.

To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10 when 
prompted near the bottom of the display, or press ESC to display the start up menu, then press 
F10. Select the Security menu and scroll down to the Utilities menu. Select Disk Sanitizer and 
select the desired drive. For a higher level of protection, select Optimum.

NOTE: This process will take a long time, and the amount of time varies based on the hard drive 
capacity.

b. Solid State Drive (SSD)

Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a third 
party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup by 
powering on the system and pressing F10 when prompted near the bottom of the display. Select 
the Security menu and scroll down to the Utilities menu. Select Secure Erase and select the 
desired hard drive.
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Non-volatile memory usage

Non Volatile 
Memory Type

Amount 
(Size)

Does this 
memory 
store 
customer 
data?

Does this 
memory 
retain data 
when power is 
removed?

What is the 
purpose of 
this memory?

How is data input into 
this memory?

How is this memory 
write protected?

Real Time Clock 
(RTC) battery 
backed-up 
CMOS 
configuration 
memory (CMOS)

256 Bytes No Yes Stores system 
date and time 
and limited 
keyboard 
controller 
data.

Using the F10 Setup utility 
or changing the 
Microsoft® Windows® date 
& time.

This memory is not 
write-protected. HP 
recommends 
password protecting 
the F10 Setup utility.

Controller (NIC) 
EEPROM

64 Kbytes 
(not 
customer 
accessible)

No Yes Store NIC 
configuration 
and NIC 
firmware.

Using a utility from the 
NIC vendor that can be run 
from DOS.

A utility is required to 
write data to this 
memory and is 
available from NIC 
vendor. Writing data to 
this ROM in an 
inappropriate manner 
will render the NIC 
nonfunctional.

Keyboard ROM 64 Kbytes 
(not 
customer 
accessible)

No Yes Stores 
firmware code 
(keyboard, 
mouse, & 
battery 
management).

Programmed at the 
factory. Code is updated 
when the system BIOS is 
updated.

A utility is required for 
writing data to this 
memory and is 
available on the HP 
website. Writing data 
to this ROM in an 
inappropriate manner 
can render the PC 
nonfunctional.

DIMM Serial 
Presence Detect 
(SPD) 
configuration 
data

256 Bytes 
per memory 
module, 
128 Bytes 
programma
bl e (not 
customer 
accessible)

No Yes Stores 
memory 
module 
information.

Programmed by the 
memory vendor.

Data cannot be written 
to this memory when 
the module is installed 
in a PC. The specific 
write protection 
method varies by 
memory vendor.

System BIOS 4 to 5 
MBytes

Yes Yes Store system 
BIOS code and 
PC 
configuration 
data.

System BIOS code is 
programmed at the 
factory. Code is updated 
when the system BIOS is 
updated. Configuration 
data and settings are 
input using the F10 setup 
utility or a custom utility.

A utility is required for 
writing data to this 
memory and is 
available on the HP 
website. Writing data 
to this ROM in an 
inappropriate manner 
can render the PC 
nonfunctional.

Intel 
Management 
Engine 
Firmware 
(present only in 
models ending 
in a ‘p’ or ‘w’ or 
with Intel 
Centrino Pro 
technology)

1.5 or 
5MByte

Yes Yes Stores 
Management 
Engine Code, 
Settings, 
Provisioning 
Data and iAMT 
third party 
data store.

Management Engine Code 
is programmed at the 
factory. Code is updated 
via Intel secure firmware 
update utility. Unique 
Provisioning Data can be 
entered at the factory or 
by an administrator using 
the Management Engine 
(MEBx) setup utility. The 
third party data store 

The Intel chipset is 
configured to enforce 
HW protection to block 
all direct read/write 
access to this area. An 
Intel utility is required 
for updating the 
firmware. Only 
firmware updates 
digitally signed by 
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contents can populated by 
a remote management 
console or local 
applications registered by 
an administrator to have 
access to the space.

Intel can be applied 
using this utility.

Bluetooth flash 2Mbit No Yes Stores 
Bluetooth 
configuration 
and firmware.

Programmed at the 
factory. Tools for writing 
data to this memory are 
not publicly available but 
can be obtained from the 
silicon vendor.

A utility is required for 
writing data to this 
memory and is made 
available through 
newer versions of the 
driver if the flash 
requires an upgrade.

802.11 WLAN 
EEPROM

4kb to 8kb No Yes Stores 
configuration 
and calibration 
data.

Programmed at the 
factory. Tools for writing 
data to this memory are 
not made public.

A utility is required for 
writing data to this 
memory and is 
typically not made 
available to the public 
unless a firmware 
upgrade is necessary 
to address a unique 
issue.

Web camera 64K bit No Yes Store Web Cam 
configuration 
and firmware.

Using a utility from the 
device manufacturer that 
can be run from Windows.

A utility is required for 
writing data to this 
memory and is 
typically not made 
available to the public 
unless a firmware 
upgrade is necessary 
to address a unique 
issue.

Fingerprint 
reader

512kByte 
Flash

Yes Yes Stores 
fingerprint 
templates.

By enrolling in HP 
ProtectTools Security 
Manager.

Only a digitally signed 
application can make 
the call to write to the 
flash.
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Questions and answers
1. How can the BIOS settings be restored (returned to factory settings)?

a. Turn on or restart the computer and press F10 when prompted near the bottom of the display.

b. Select File, then select Restore defaults.

c. Follow the on-screen instructions.

d. Select File, save changes and exit, then press Enter.

2. What kind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory 
module? How would this data be written?

The DIMM SPD memory contains information about the memory module such as size, serial number, 
data width, speed/timing, voltage and thermal information. This information is written by the module 
manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is 
installed in a PC. Third party tools do exist that can write to the EEPROM when the memory module is 
not installed in a PC. There are various third party tools available to read SPD memory.

3. Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip writable, and if so 
how?

The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform the 
write function.

4. In some PC systems, the Firmware Hub for System BIOS is a flash memory chip so that updates can 
be written by the customer. Is this true for these BIOS chips?

Yes, they are flash memory chips.

5. What is meant by “Restore the nonvolatile memory found in Intel-based system boards”?

This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration data.

6. Does resetting the CMOS configuration memory return the PC back to factory defaults?

The process of resetting the CMOS will return certain system settings to factory default but will not reset 
many of the system data and configuration defaults to their factory settings. To return these system 
data and configuration defaults to factory settings, refer to question and answer 1 and follow the 
instructions for returning the BIOS settings to factory defaults.
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18 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120 
volts ac, or from 220 to 240 volts ac.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or 
region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region 
where the computer is used.

Requirements for all countries and regions
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in 
the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating of 125 
or 250 V ac, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet 
C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Argentina IRAM 1

Australia SAA 1

Austria OVE 1

Belgium CEBEC 1

Brazil ABNT 1

Canada CSA 2

Chile IMQ 1

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

India ISI 1

Israel SII 1

Italy IMQ 1
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Country/region Accredited agency Applicable note number

Japan JIS 3

The Netherlands KEMA 1

New Zealand SANZ 1

Norway NEMKO 1

The People's Republic of China CCC 4

Saudi Arabia SASO 7

Singapore PSB 1

South Africa SABS 1

South Korea KTL 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 6

Thailand TISI 1

The United Kingdom ASTA 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler and 
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2. The flexible cord must be Type SVT/SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15 A, 125 V ac) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL mark. UL file number must be on 
each element.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese 
Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75mm2 or 1.25mm2 conductor size. The wall plug must be a 
two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the CCC certification mark.

5. The flexible cord must be Type H05VV-F 3X0.75mm2 conductor size. KTL logo and individual approval number must be on each 
element. Corset approval number and logo must be printed on a flag label.

6. The flexible cord must be Type HVCTF 3X1.25mm2 conductor size. Power cord set fittings (appliance coupler, cable, and wall 
plug) must bear the BSMI certification mark.

7. For 127 V ac, the flexible cord must be Type SVT or SJT 3 x 18 AWG, with plug NEMA 5-15P (15 A, 125 V ac), with UL and CSA or C-
UL marks. For 240 V ac, the flexible cord must be Type H05VV-F 3X0.75/1.00mm2 conductor size, with plug BS 1363/A with BSI 
or ASTA marks.
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19 Recycling

Battery
When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose of the 
battery in general household waste. Follow the local laws and regulations in your area for battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable 
batteries. For more information about recycling programs, see the HP Web site at http://www.hp.com/recycle.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the backlight to 
avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only components 
intended for recycling purposes are the LCD panel and the backlight. When you remove these components, 
handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly that 
might require special handling at end-of-life. Disposal of mercury may be regulated because of 
environmental considerations. For disposal or recycling information, contact your local authorities, or see the 
Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be 
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details, such 
as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one computer 
model to another.

Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

Battery 131

http://www.eiae.org


2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the 
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).

4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.
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6. Remove the display panel assembly (2) from the display enclosure.

7. Position the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display 
panel frame.

10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

Display 133



12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Position the display panel right-side up.

15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Position the display panel upside-down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the 
backlight to avoid damaging this component and causing exposure to the mercury.
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17. Remove the backlight frame from the display panel.

18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.
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23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter, spare part numbers 21
AC adapter/battery light 13
antennas

disconnecting 38
audio, product description 2
audio-in (microphone) jack, 

identifying 14
audio-out (headphone) jack, 

identifying 14

B
backup 113
Backup and Restore 101
backup tools 99
backups 107

creating 100
recovering 101

base enclosure, spare part number
18

battery
spare part number 18, 29

battery bay, identifying 12
battery connector cable

removal 61
spare part number 61

battery connector cable, illustrated
19

battery release latch 11
BIOS

determining version 80, 85, 91, 
95

downloading an update 81, 86, 
91, 96

updating 80, 85, 91, 95
Blu-ray ROM DVD±RW SuperMulti

specifications 122
Blu-ray ROM DVD±RW SuperMulti DL 

Drive, spare part number 19, 21, 
36

Bluetooth card
spare part number 38

Bluetooth label 15
boot order

changing 111

bottom 15
buttons

left TouchPad 7
optical drive eject 14
power 9
right TouchPad 7

C
Cable Kit

contents 19
spare part number 19

cables, service considerations 24
caps lock light, identifying 8
card reader board

removal 53
spare part number 17, 53

chipset, product description 1
components

bottom 11
display 6
front 12
left side 13
right side 14
top 7

computer reset 115
Computer Setup

navigating and selecting 79, 84, 
89, 94

restoring factory settings 80, 
85, 90, 95

computer setup
navigating and selecting 94
restoring factory settings 95

computer specifications 117
connector, power 13
connectors, service considerations

24

D
diskette drive

precautions 24
display assembly

removal 70
spare part numbers 70

display bezel
removal 72
spare part numbers 20

display component recycling 131
display components, spare part 

numbers 20
display hinge

removal 74
Display Hinge Kit

spare part numbers 20
display panel

product description 1
display rear cover

spare part number 21
display specifications 118
Driver Recovery DVD,

creating 99
using for restore 102

drives
preventing damage 24

DVD-ROM drive, spare part number
19, 21, 36

DVD-ROM drive, specifications 122
DVD±RW SuperMulti DL Drive

specifications 121
DVD±RW SuperMulti DL Drive, spare 

part number 19, 21, 36

E
electrostatic discharge 25
esc key, identifying 10
Ethernet, product description 2
external media cards, product 

description 3
external monitor port 13

F
f11 recovery 102, 105
fan

removing 59
spare part number 18

fingerprint reader
identifying 10
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fingerprint reader assembly
removal 49
spare part number 17, 49

fn key, identifying 10
function board

removal 52
spare part number 17, 52

function keys, identifying 10

G
graphics, product description 1
grounding equipment and methods

27

H
hard drive

precautions 24
product description 2
removing 32
spare part numbers 18, 21, 32
specifications 119

Hard Drive Hardware Kit, spare part 
number 21

hard drive light 12
hard drive recovery 102, 105
hard drive, identifying 11
HDMI port

identifying 13
headphone (audio-out) jack 14
heat sink

removal 68
spare part number 18

heat sink assembly
spare part number 18

hinge
removal 74

HP PC Hardware Diagnostics (UEFI)
using 97

HP Recovery Disc Creator, using 99
HP Recovery Manager

correcting boot problems 111
starting 110

HP Recovery media
creating 107
recovery 110

HP Recovery partition
checking for presence 102
recovery 110
removing 112
using for recovery 102

I
integrated numeric keypad, 

identifying 11
integrated webcam light, 

identifying 6
internal display switch 6
internal microphones, identifying 6

J
jacks

audio-in (microphone) 14
audio-out (headphone) 14
network 13
RJ-45 (network) 13

K
keyboard

product description 3
removal 40
spare part numbers 17, 40

keypad
integrated numeric 11

keys
esc 10
fn 10
function 10
Windows key 10

L
labels

Bluetooth 15
regulatory 15
serial number 15
service 15
wireless certification 15
WLAN 15

latch, battery release 11
legacy support, USB 79, 84, 89, 94
lights

AC adapter/battery 13
caps lock 8
hard drive 12
microphone mute 8
num lock 8
power 8
RJ-45 (network) 13
TouchPad 8
webcam 6
wireless 8

M
mass storage devices, spare part 

numbers 21
memory card reader, identifying 12
memory module

identifying 11
product description 1
removal 34
spare part numbers 17, 34

microphone (audio-in) jack
product description 2

microphone (audio-in) jack, 
identifying 14

microphone module
spare part number 20

microphone mute light, identifying
8

minimized image recovery 110
minimized image, creating 109
model name 1

N
network jack, identifying 13
num lock light 8

O
operating system, product 

description 4
optical drive

precautions 24
product description 2
removal 36
spare part numbers 19, 21, 36
specifications 121, 122

optical drive eject button, 
identifying 14

optical drive extension board
removal 65
spare part number 18, 65

optical drive, identifying 14
original system recovery 109

P
packing guidelines 26
plastic parts 23
pointing device, product 

description 3
ports

external monitor 13
HDMI 13
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product description 3
USB 14

power button
identifying 9

power button board assembly
removal 50
spare part number 17, 50

power cable
removal 77
spare part number 18, 77

power connector, identifying 13
power cord

set requirements 129
spare part numbers 21, 22

power lights 8
power requirements, product 

description 3
processor

product description 1
product description

audio 2
chipset 1
display panel 1
Ethernet 2
external media cards 3
graphics 1
hard drives 2
keyboard 3
memory module 1
microphone 2
operating system 4
optical drives 2
pointing devices 3
ports 3
power requirements 3
processors 1
product name 1
security 3
serviceability 5
webcam 2
wireless 3

product name 1
product name and number, 

computer 15

R
recover

options 109
recovery 106, 113

discs 108, 110

HP Recovery Manager 109
media 110
starting 110
supported discs 108
system 109
USB flash drive 110
using HP Recovery media 108

recovery media
creating 99, 107
creating using HP Recovery 

Manager 108
using for restore 102

recovery partition 102, 105
removing 112

recovery tools 99
recovery tools, Windows 101
recovery, system 101
refresh 106
regulatory information

regulatory label 15
wireless certification labels 15

removal/replacement
preliminaries 23
procedures, Authorized Service 

Provider 44
procedures, Customer Self-

Repair 28
reset 106

computer 115
steps 115

restoring the hard drive 102, 105
RJ-45 (network) jack, identifying 13
RJ-45 (network) lights, identifying

13
RTC battery

removal 66
spare part number 18, 66

S
Screw Kit, spare part number 22
security cable slot, identifying 14
security, product description 3
serial number 15
serial number, computer 15
service considerations 23
service door

spare part number 18, 30
service labels, locating 15
serviceability, product description 5

setup utility
navigating and selecting 79, 84, 

89
restoring factory settings 80, 

85, 90
slots

security cable 14
solid-state drive

spare part numbers 18, 21, 32
specifications 120

speaker assembly
removal 47
spare part number 18, 47

speakers, identifying 10
specifications

Blu-ray ROM DVD±RW 
SuperMulti 122

computer 117
display 118
DVD-ROM drive 122
DVD±RW SuperMulti DL Drive

121
hard drive 119
optical drive 121, 122
solid-state drive 120

Startup Repair, using 101
static-shielding materials 27
supported discs, recovery 108
Sure Start

using 93
system board

removal 62
spare part numbers 17, 62

system recovery 109
system restore point

creating 108
system restore point, creating 107

T
thermal material, replacement 69
tools required 23
top cover

removal 44
spare part number 17, 44

TouchPad
buttons 7

touchpad button board
removal 57
spare part number 17, 57

TouchPad light, identifying 8
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TouchPad zone
identifying 7

TPM settings 92
transporting guidelines 26
traveling with the computer 15

U
Ubuntu

remove everything and reinstall 
option 115

USB 3.0 port 13
USB legacy support 79, 84, 89, 94
USB ports, identifying 13, 14
USB/audio board

removal 55
spare part number 17, 55

V
vents, identifying 11, 13

W
webcam

identifying 6
product description 2

webcam light, identifying 6
webcam module

removal 73
spare part number 20

Windows
Refresh 106
Reset 106
system restore point 107, 108

Windows 7 operating system DVD
creating 99
using for restore 102

Windows 7 operating system media
creating 99
using for restore 102

Windows key, identifying 10
Windows operating system DVD

106
Windows Startup Repair, using 101
Windows tools

using 108
wireless antennas

disconnecting 38
wireless certification label 15
wireless light 8
wireless, product description 3
WLAN antennas

spare part number 20

WLAN antennas, identifying 6
WLAN device 15
WLAN label 15
WLAN, identifying 11
WLAN/Bluetooth combo card

removal 38
spare part number 18, 38

workstation guidelines 26
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